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Copyright
Copyright © 2007 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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 RM-156 product selection
RM-156 is a WCDMA/GSM dual mode handportable phone, supporting WCDMA 2100/EGSM 900/1800/1900.

According to GSM standard 05.05 it responds to class 4 (max. 2 W) in EGSM900, class 1 (1 W) in GSM1800 and
class 1 in GSM1900. The device supports EGPRS (EDGE) class B as well as Bluetooth 2.0 + EDR (Enhanced Data
Rate) standard. The handset has a full phase 2 Type Approval and it complies with the GSM Type Approval.
RM-156 also has a full CE approval and FCC (Federal Communications Commission) approval.

RM-156 supports two-way video calls with two integrated cameras. It is an MMS (Multimedia Messaging
Service) enabled phone with a large bright colour display and an integrated 3.0 megapixel rear camera (3x
optical zoom) and a CIF digital front camera.

The MMS implementation follows the OMA (Open Mobile Alliance) MMS standard release 1.2.

WAP 2.0 compatible browser supports XHTML Mobile Profile (MP) and uses a TCP/IP stack to communicate
with a gateway in network.

RM-156 uses a Symbian 9.1 operating system and support also MIDP (Mobile Information Device Profile) Java
2.0 & CLDC 1.1 (Connected Limited Device Configuration), providing a good platform for 3rd party applications.

Figure 1 View of RM-156

 Product features and sales package

Hardware characteristics
• Dual-mode: WCDMA2100/EGSM900/GSM1800/GSM1900 MHz

• Speech Codecs supported: AMR/FR/EFR
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• WCDMA 2100 MHz with simultaneous voice and packet data (PS max speed DL/UL= 384/384kbps, CS max
speed 64kpbs)

• Dual Transfer Mode (DTM) support for simultaneous voice and packet data connection in GSM/EDGE
networks. Simple class A, multi slot class 11, max data speed to be: 177.6/118.4 kbits/s

• EGPRS class B, multi slot class 32, (5 Rx + 3 Tx / Max Sum 6), max speed DL/UL= 296 / 177.6 kbits/s.

• GPRS class B, multi slot class 32, (5 Rx + 3 Tx / Max Sum 6), max speed DL/UL= 107/64.2 kbits/s.

• 3.2 megapixel camera (2048 x 1536) with 3x continuous optical zoom and up to 20x digital zoom; High
quality lens solution.

• Stereo microphone.

• LED Flash and red recording indicator LED.

• Sub camera, CIF (352 x 288) sensor.

• Large bright 2.4” QVGA (240 x 320 pixels) TFT colour display with 16.7M colours and wide viewing angle.
Ambient light detector - used to optimize display brightness and power consumption

• Sub-display – 1.1” PM-OLED colour display (128x36), 65,536 colours.

• Keys : ITU numeric keys, Send/End keys, S60 keys (Application, Edit, Clear, 5-way navi key), Operator/
Multimedia key, Left/Right selection keys, Upper/Lower Landscape selection keys, Shutter key, Zoom key,
Side 5-way navi key, Camera mode key, Flash key, Power key.

• 50 Mbytes internal user memory

• Internal antennas

• Integrated handsfree speaker

• Vibrator

• Stereo FM radio

• (U)SIM chip slot (1.8 and 3.0 V)

• TV output support (PAL/NTSC)

• miniSD memory card support (hot swappable)

• Pop-Port™ interface with USB 2.0 connectivity

• WLAN - IEEE802.11 g /b

• Bluetooth wireless technology 2.0

• Infrared

Software platform
• Symbian 9.1

• Nokia Series 60 3.0 User Interface : C++ and Java SDKs

User interface
• Imaging

• Capture

• Video: Record DVD-like MPEG-4 VGA 30 fps movies with stereo audio and stabilization.

• Photos: Take high quality 3.2 megapixel pictures. User settings for Scene, Flash, White Balance,
Exposure and Colour tone. Self timer support.

• Sequence mode: Capture 6 pictures in 2 seconds.

• Edit

• Photo editor
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• Video editor

• View

• Slideshow from Gallery

• Show photo and videos on TV

• Share

• Sending via Bluetooth, Infrared, MMS, e-mail

• Online Album : Image/Video uploading from Gallery

• Print

• Nokia XpressPrint – direct printing from phone, memory card or via online album.

• Store

• Gallery with album support

• Nokia Lifeblog

• Messaging

• • Multimedia Messaging

• Concatenated SMS (MO/MT)

• E-mail (SMTP, IMAP4, POP3)

• Predictive text input

• Music

• Music player : Supports MP3/AAC/WMA with playlists

• Stereo FM radio + Visual radio support

• PIM

• Contacts, Calendar, To-do, Notes

• Recorder, Calculator, Clock, Converter

• Synchronization

• Local/Remote (using SyncML)

• Data: Calendar, Contacts, To-do, Notes, E-mail

• PC Applications: Microsoft Outlook (98, 2000, 2002, 2003), Outlook Express, Lotus Organizer (5.0, 6.0),
Lotus Notes (5.0, 6.0)

• Phone

• 3GPP Rel ’99 compliant

• Voice dialling (Flexible SIND)

• Voice commands

• Push to Talk (PoC)

• Java: MIDP2.0

• Browser : full web browser

• Personalization

• Themes

• SP-MIDI (64 polyphonics), True Tones

• Location based services

• MT-LR Control Plane Cell-Id Positioning with DTAP LCS Location Notification
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Sales package
• Transceiver with lens cover

• BL-5F li-ion battery cell

• Mini-SD memory card (1GB)

• CA-53 connectivity cable (USB)

• CA-64U video out cable

• AC-4 travel charger

• CP-83 carrying case

• CP-84 wrist strap

• HS-23 stereo headset

• User guide, Quick start guide, and add-on application guide

• DVD-ROM (with PC Suite and other applications)

 Mobile enhancements

Table 1 Audio

Enhancement Type

Headsets

Wireless Headset HS-11W

HS-26W

HS-37W

HDW-3

BH-300 (HS-50W)

HS-36W

Wireless Clip-on Headset HS-21W

Wireless Image Headset HS-13W

Wireless Boom Headset HS-4W

Bluetooth Headset BH-800 (HS-24W)

BH-900 (HS-25W)

BH-700(HS-57W)

BH-200 (HS-58W)

BH-600(HS-59W)

BH-301 (HS-51W) PR2

BH-302 (HS-73W)

BH-202 (HS-38W)

BH-801 (HS-64W) PR2

BH-500 (HS-39W) PR2

BH-501 (HS-71W)
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Enhancement Type

Wireless Stereo Headset HS-12W (PR-2)

HS-34W (PR-2)

Boom Headset HDB-4

Headset HS-5

Activity Stereo Headset HS-8

Stereo Headset HS-23

HDS-3

Stereo Fashion Headset HS-3

Activity Stereo Headset HS-29

Display Headset HS-6

Music Headset HS-20

Fashion Stereo Headset HS-31

Stereo Headset HDS-3

Music Display Headset HS-69

Other

Music Stand MD-1

Audio Adapter AD-15

AD-46

Inductive Loopset LPS-4

Mini Speaker MD-4

Table 2 Car

Enhancement Type

Car kits

Advanced Car Kit CK-7W

CK-20W

Wireless Car Kit CK-1W

Car Kit N616

Other car enhancements

Mobile Charger DC-4

Headrest Handsfree BHF-3

Wireless Plug-in Car Handsfree HF-3

HF-6W

HF-35W

HF-33W (PR2)
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Enhancement Type

Universal Mobile Holder CR-39

Wireless GPS Module LD-3W

GPS module LD-2

Table 3 Carrying

Enhancement Type

Carrying case CP-83

Wrist strap CP-84

Table 4 Data

Enhancement Type

Connectivity Cable CA-53

Video out cable CA-64U

Charging Data Cable CA-70

Wireless GPS Module LD-1W

Memory Cards Mini SD 64MB

Mini-SD 128MB

Mini-SD 256MB

Mini-SD 512MB

Mini-SD 1GB

Mini SD 2GB MU-36

TTY Adapter HDA-10

Table 5 Messaging

Enhancement Type

Wireless Keyboard SU-8W

Digital Pen SU-1B

SU-27W

Table 6 Power

Enhancement Type

Chargers

Travel Charger AC-4

AC-5

Compact charger AC-3
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Enhancement Type

Charging Adapter CA-44

Batteries

Battery BL-5F

 Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T) Weight (g) Volume (cm3)

Transceiver with BL-5F
950 mAh li-ion battery
back

46.2 x 40 x 5.4 21 9.98

Main RF characteristics for triple-band (EGSM900/GSM1800/GSM1900) and WCDMA phones

Parameter Unit

Cellular system EGSM900, GSM1800/1900 and WCDMA

Rx frequency band EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA: 2110 - 2170 MHz

Tx frequency band EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA: 1920 - 1980 MHz

Output power GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA -50 … 21 dBm

Number of RF channels GSM900: 125

GSM1800: 375

GSM1900: 300

WCDMA: 277

Channel spacing 200 kHz

Number of Tx power levels GSM900: 15

GSM1800: 16

GSM1900: 16
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Operating times

Battery Talk time Stand-by Still
Images

Video
capture

Video call
talk time

Video
playback

time

Music
playback

time

BL-5F

950 mAh

3.1 - 3.9
hrs (GSM)

1.7 - 3.3
hrs
(WCDMA )

9.3 - 11.8
days (GSM)

7.8 - 9.4
days
(WCDMA)

up to 291
pictures

(3M, flash
off)

up to 112
min (VGA,
30fps)

up to 107
min

up to 205
min (VGA,
30fps)

up to 6.3
hours
(offline
mode)

Note: Operating times with in-box battery. Variation in operation times will occur depending on
SIM card, network settings and usage.

Charging times

AC-4

1 h 15 min

Environmental conditions

Table 7 Environmental conditions

Environmental
condition

Ambient temperature Notes

Normal operation -15oC...+55oC Specifications fulfilled

Reduced performance -20oC...-15oC

+35oC...+55oC

Main camera performance reduced.

Charging allowed -25oC...+50oC

Long term storage
conditions

0oC...+85oC
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 Spare parts overview and exploded view
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 Mechanical spare parts list

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS). To ensure you are always
using the latest codes, please check the PWS on a daily basis.

ITEM/ CIRCUIT
REF. QTY SPARE PART DESCRIPTION

A1 1 FLIP A-COVER ASSY (I001 - I003)

I001 1 FLIP A-COVER

I002 1 FLIP SOFT KEYMAT

I003 1 EARPIECE GASKET

I004 1 EARPIECE

I005 1 MAIN LCD

A2 1 FLIP FRAME ASSY (I006 - I007)

I006 1 CMOS CAMERA

I007 1 1 UY FLIP PWB FLEX

I008 1 SUB LCD

I009 1 FLIP B-COVER

I010 4 SCREW M1.7 x 3.1

I011 2 SCREW M1.8x2.7

I012 1 SUB LCD WINDOW ASSY

A3 1 HINGE CAPTURE ASSY (I101 - I107)

I101 1 CAPTURE KEY COVER PAINTED

I102 1 CAPTURE KEY BUTTON SPUTTERING

I103 1 ZOOM KEY LEVER PAINTED

I104 1 CAPTURE RETURN SPRING

I105 1 HINGE ASSEMBLY

I106 1 CAPTURE KEY INNER COVER

I107 1 ADHESIVE FOR DETECTOR SWITCH

I108 2 SCREW M2X3.7 TORX PLUS 6

I109 1 CABLE ASSY

I110 1 CAMERA MODULE

I111 1 CAMERA SUPPORT FRAME ASSY

I112 1 CAMERA BEZEL

I113 1 LENS CAP ASSY

I201 1 KEYMAT
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ITEM/ CIRCUIT
REF. QTY SPARE PART DESCRIPTION

A4 1 GRIP A-COVER ASSY (I202 - I205, I211, A5, A6)

I202 1 GRIP A-COVER

I203 1 PILLOW

I204 1 GRIP BUMPER A ADHESIVE

I205 1 GRIP BUMPER A

A5 1 UI ASSY (I206 - I210)

I206 1 EL DOMESHEET ASSY

I207 1 JOYSTICK

I208 1 SIDEKEY DOME SWITCH

I209 1 JOYSTICK HAT

I210 1 MICROPHONE

I211 1 CONN 2mm DC-JACK

A6 1 DIGITAL MIC ASSY (I212 - I213)

I212 2 MIC

I213 1 POWER KEY DOME SWITCH

A7 1 1UV LIGHT SWAP PACKAGE (I214 - I221)

I214 1 BB OMAP SHIELD LID

I215 1 BB CAMERA SHIELD LID

I216 1 RF WLAN SHIELD LID

I217 1 BB FLASH SHIELD LID

I218 1 RF LID

I219 1 1UV ENGINE MODULE

I220 1 WCDMA LID (RM-156 only)

I221 1 TYPE LABEL

I222 1 LABEL PLATE

A8 1 ANTENNA ASSY (I223 - I224)

I223 1 ANTENNA

I224 1 IHF SPEAKER

I225 1 GRIP INNER FRAME

I226 1 CABLE CLAMP

I227 1 CAMERA GROUND CLIP

I228 1 SIM SHIELD COVER

I229 1 SIM INSULATOR PRINTED
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ITEM/ CIRCUIT
REF. QTY SPARE PART DESCRIPTION

I230 1 GIF GND CLIP

I231 1 CUSHION BT

A9 1 GRIP B-COVER ASSY (I232 - I235)

I232 1 GRIP B-COVER

I233 1 BT/WLAN ANTENNA

I234 1 ORNAMENT B

I235 1 SD HATCH

I236 1 POP-PORT HATCH

I237 1 ORNAMENT L ASSY (incl. Adhesive)

I238 1 ORNAMENT R ASSY

I239 1 SIDE KEYMAT

I240 4 SCREW RF 1.8X9

I241 1 GRIP C-COVER ASSY

 Component parts lists and layouts

Engine PWB component parts list

Table 8 Component parts list 1UV_060a

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS). To ensure you are always
using the latest codes, please check the PWS on a daily basis.

Item Side Grid ref. Type Description and value

A1 Top G 7
SHIELD_040_0136
93 RF SHIELD ASSEMBLY ~ ~

A2 Top G 4 SHIELD_WCDMA
WCDMA-SHIELD
ASSEMBLY ~ ~

A3 Bot F 12
SHIELD_040_0230
57

RF WLAN SHIELD ASSY
040-023057 ~ ~

A4 Top F 14
SHIELD_040_0230
51

BB OMAP SHIELD ASSY
040-023051 ~ ~

A5 Bot D 14
SHIELD_040_0230
54

BB FLASH SHIELD ASSY
040-023054 ~ ~

A6 Bot I 14
SHIELD_040_0230
48

BB CAMERA SHELD ASSY
040-023048 ~ ~

B8100 Top D 3
MIC_OBE_415S42_
RC3310CL

CLAPTON EMC
MICROPHONE MOD
-42DB ~ ~

C1001 Top F 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V
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Item Side Grid ref. Type Description and value

C2000 Top C 4 0402C Chipcap 5% NP0 27p 50V

C2002 Bot D 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2003 Bot D 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C2033 Bot C 5 0402C Chipcap 5% NP0 10p 50V

C2034 Bot C 5 0402C Chipcap 5% NP0 10p 50V

C2035 Bot C 5 0402C Chipcap 5% NP0 10p 50V

C2036 Bot C 5 0402C Chipcap 5% NP0 10p 50V

C2039 Top C 4 0603C_H0.95
CHIPCAP X5R 470N K
25V 0603 470n 25V

C2041 Top I 13 0402C Chipcap 5% NP0 68p 50V

C2042 Top J 13 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C2043 Bot C 7 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C2044 Bot D 8 0402C Chipcap 5% NP0 22p 50V

C2045 Bot D 8 0402C Chipcap 5% NP0 22p 50V

C2070 Top C 4
TANT_C_6.2X3.4_H
1.7

CHIPTCAP 150U M 10V
6X3.2X1.5 150u_10V 10V

C2151 Bot F 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2152 Bot F 5 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2153 Bot F 5 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2155 Bot I 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2156 Bot I 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2157 Bot I 4 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C2158 Top E 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C2165 Top D 11 0402C Chipcap 5% X7R 820p 50V

C2170 Top E 4 0402C Chipcap 5% NP0 22p 50V

C2171 Bot J 5 0402C Chipcap 5% NP0 27p 50V

C2172 Bot G 5 0402C Chipcap 5% NP0 27p 50V
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Item Side Grid ref. Type Description and value

C2750 Bot H 14 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4200 Top C 14 0405_DUAL
CHIPCAP NETWORK X5R
2X1U5 K 6V3 0405 2x1u5 6.3V

C4201 Top D 15 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C4203 Top D 14 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4204 Top C 14 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4205 Top D 13 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C4206 Top C 15 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4207 Top I 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4208 Top D 14 0405_DUAL
CHIPCAP NETWORK X5R
2X1U5 K 6V3 0405 2x1u5 6.3V

C4209 Top D 13 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C4211 Top D 14 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4212 Top D 14 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4213 Top C 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4214 Top C 15 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4215 Top C 15 0405_DUAL
CHIPCAP NETWORK X5R
2X1U5 K 6V3 0405 2x1u5 6.3V

C4216 Top D 14 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C4219 Top H 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4800 Top F 14 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4801 Top G 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4802 Top H 12 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V
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Item Side Grid ref. Type Description and value

C4803 Top I 13 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4804 Top F 14 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4806 Top F 13 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4807 Top F 12 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4808 Top G 12 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4813 Top I 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4814 Top G 12 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4816 Top F 13 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4817 Top G 12 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4818 Top H 12 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4819 Top H 12 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4820 Top F 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4821 Top G 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4822 Top H 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4823 Top I 14 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4824 Top F 13 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4825 Top F 15 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4826 Top F 14 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4828 Top F 15 0402C Chipcap 5% NP0 22p 50V

C4830 Top G 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4832 Top I 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V
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Item Side Grid ref. Type Description and value

C4833 Top I 14 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4834 Top F 13 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4835 Top F 14 0402C
CHIPCAP X5R 1U5 K 4V
0402 1u5 4V

C4836 Top F 14 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4838 Top H 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C4840 Top I 15 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C4841 Top I 14 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C4850 Top I 15 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C5250 Bot F 7 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C5251 Bot G 7 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C6100 Top D 8 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C6101 Top D 8 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C6150 Top C 9 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C6151 Top C 7 0402C
CHIPCAP X5R 1U K 6V3
0402 1u0 6.3V

C6157 Top C 7 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C6158 Top C 7 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C6195 Top C 7 0402C Chipcap 5% NP0 100p 50V

C6300 Bot E 12 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6301 Bot F 12 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6302 Bot D 13 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C6304 Bot E 11 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V
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C6305 Bot E 12 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6306 Bot E 13 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C6421 Bot F 13 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C6434 Bot E 13 0603C
CHIPCAP X5R 2U2 K 6V3
0603 2u2 6V3

C6435 Bot F 11 0603C_H0.95
CHIPCAP X5R 1U0 K 10V
0603 1u0 10V

C7400 Top I 8 0402C
CHIPCAP N750 1P8 C
50V 0402 1p8 50V

C7504 Top J 8 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7510 Top H 4 0402C Chipcap 5% NP0 10p 50V

C7511 Top G 4 0402C Chipcap 5% NP0 10p 50V

C7512 Top F 4 0402C
Chipcap X7R 5% 25V
0402 4n7 25V

C7513 Top E 7 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7514 Top E 8 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7515 Top G 6 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7516 Top G 6 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7517 Top E 7 0402C Chipcap 5% X7R 3n9 50V

C7518 Top E 7 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C7520 Top H 6 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C7522 Top E 7 0603C
CHIPCAP NP0 2N2 G 16V
0603 2n2 16V

C7524 Top E 6 0402C Chipcap 5% NP0 10p 50V

C7525 Top E 7 0402C
CHPCAP NP0 470P J 50V
0402 470p 50V

C7526 Top E 6 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C7530 Top F 5 0402C
Chipcap X7R 5% 25V
0402 4n7 25V
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Item Side Grid ref. Type Description and value

C7541 Top F 5 0603C
CHIPCAP X5R 10UF 6V3
0603 10u 4V

C7587 Top F 4 0603C
CHIPCAP X5R 4U7 K 6V3
0603 4u7 6.3V

C7600 Top I 6 0402C Chipcap 5% NP0 15p 50V

C7612 Top H 5 0402C
CERCAP X7R 22N K 16V
0402 22n 16V

C7621 Top E 6 0402C
CHIPCAP X7R 33N K 10V
0402 33n 10V

C7660 Top J 6 0402C Chipcap +-0.25pF NP0 1p8 50V

C7663 Top E 6 0402C
CHIPCAP NP0 0P5 C 50V
0402 0p5 50V

C7664 Top J 4 0402C Chipcap 5% NP0 27p 50V

C8521 Top D 16 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C8522 Bot K 12 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C8704 Bot I 15 0805C
CHIPCAP X5R 2U2 K 10V
0805 2u2 10V

C8705 Bot I 14 0402C Chipcap 5% NP0 27p 50V

C8706 Bot H 15 0805C
CHIPCAP X5R 2U2 K 10V
0805 2u2 10V

C8707 Bot I 15 0603C_H0.95
CHIPCAP X5R 1U0 K 10V
0603 1u0 10V

C8708 Bot I 15 0402C Chipcap 5% NP0 10p 50V

C8709 Bot I 15 0603C_H0.95
CHIPCAP X5R 1U0 K 10V
0603 1u0 10V

C8710 Bot I 14 0603C_H0.95
CHIPCAP X5R 1U0 K 10V
0603 1u0 10V

C8711 Bot I 14 0402C Chipcap 5% NP0 10p 50V

C8712 Bot I 14 0603C_H0.95
CHIPCAP X5R 1U0 K 10V
0603 1u0 10V

C8721 Bot D 14 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C8726 Bot G 16 0603C
CHIPCAP X5R 10UF 6V3
0603 10u 4V

C8727 Bot E 16 0603C
CHIPCAP X5R 10UF 6V3
0603 10u 4V

C8728 Bot F 16 0603C
CHIPCAP X5R 10UF 6V3
0603 10u 4V
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C8729 Bot F 16 0603C
CHIPCAP X5R 10UF 6V3
0603 10u 4V

C8731 Top I 14 0402C Chipcap 5% NP0 10p 50V

C8735 Bot C 14 0805C
CHIPCAP X5R 2U2 K 25V
0805 2u2 25V

C8900 Bot I 11 0402C Chipcap 5% NP0 27p 50V

C8901 Bot H 11 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C8906 Bot I 13 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C8908 Bot I 11 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C8920 Bot G 12 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C8921 Bot G 12 0402C Chipcap 5% NP0 27p 50V

C8922 Top D 10 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C8923 Top D 10 0402C
Chipcap X7R 10% 50V
0402 1n0 50V

C8924 Bot H 11 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C8990 Bot J 11 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C9100 Top C 11 0402C
CHIPCAP X5R 1U K 6V3
0402 1u0 6.3V

C9101 Top C 10 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C9106 Top J 5 0402C Chipcap 5% NP0 18p 50V

C9107 Top I 5 0402C Chipcap 5% NP0 27p 50V

C9300 Top K 10 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C9301 Top I 5 0402C Chipcap 5% X7R 1n0 50V

C9302 Top J 4 0402C Chipcap 5% X7R 1n0 50V

C9303 Top J 5 0402C Chipcap 5% NP0 27p 50V

C9330 Top E 6 0402C
CHIPCAP NP0 0P5 C 50V
0402 0p5 50V

C9401 Top F 8 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C9402 Top F 8 0402C
Chipcap X7R 10% 16V
0402 10n 16V
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C9900 Bot K 12 0402C
CHIPCAP X5R 1U K 6V3
0402 1u0 6.3V

C9902 Bot J 13 0402C Chipcap 5% NP0 68p 50V

C9903 Bot K 13 0402C
Chipcap X7R 10% 16V
0402 10n 16V

C9905 Top D 13 0603C_H0.95
CHIPCAP X5R 1U0 K 10V
0603 1u0 10V

C9906 Top D 12 0402C Chipcap 5% NP0 10p 50V

C9907 Top E 12 0805C
CHIPCAP X5R 22U M 6V3
0805 22u 6V3

C9911 Top F 6 0402C Chipcap 5% NP0 47p 50V

C9913 Bot E 5 0402C Chipcap 5% NP0 27p 50V

C9916 Top C 13 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C9917 Top D 13 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C9918 Top I 4 0402C Chipcap +-0.25pF NP0 1p8 50V

C9919 Top F 8 0402C Chipcap 5% NP0 15p 50V

C9921 Top J 5 0402C Chipcap +-0.25pF NP0 2p2 50V

C9930 Top J 5 0402C Chipcap 5% X7R 1n2 50V

C9940 Top G 8 0402C Chipcap 5% NP0 15p 50V

C9941 Top F 8 0402C
CHIPCAP NP0 1P0 B 50V
0402 1p0 50V

C9942 Top F 8 0402C Chipcap 5% NP0 15p 50V

C9951 Top F 6 0402C Chipcap 5% NP0 33p 50V

C9952 Top E 5 0402C Chipcap 5% NP0 47p 50V

C9953 Top D 5 0402C Chipcap +-0.25pF NP0 3p3 50V

D1001 Top G 14 FBGA152_EMPTY
COMBO 1G M3 + 512M
DDR DRAM FBGA152 ~ ~

D2031 Top I 14 PDSO_G6
VIDEO AMPLIFIER
OPA361 3V SC70 ~ ~

D2032 Bot C 8 XBGA_N4
TI SINGLE BUFFER
SN74LVC1G07YZT ~ ~

D4800 Top G 14 PBGA447
MCU OMAP2420POP
PS2.2 N1 PBGA447 ~ ~

D4801 Top I 14
XBGA_N6_1.45X0.
95_H0.625

IC 2XBUFFER
74LVC2G34YZTR
WCSP6 ~ ~
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D8720 Bot D 14 XBGA_N5_H0.625

OR-GATE 2INPUT
74LVC1G32YZTR
WCSP-5 ~ ~

D8721 Bot E 15 XBGA_N5_H0.625

OR-GATE 2INPUT
74LVC1G32YZTR
WCSP-5 ~ ~

D8740 Bot C 13 QFN16P
WHITE LED DRIVER
AN30251A QFN16 ~ ~

D9300 Top K 11
XBGA_N6_1.45X0.
95_H0.625

IC 2XBUFFER
74LVC2G34YZTR
WCSP6 ~ ~

E1000 Bot G 3
SPACER_R1.75_H0.
33 GROUND SPACER PAD ~ ~

E1001 Bot I 3
SPACER_R1.75_H0.
33 GROUND SPACER PAD ~ ~

F2000 Top C 3
0603_FUSE_AVX2
MATS SM FUSE F 2.0A 32V 2A ~

F8720 Bot D 14
0603_FUSE_AVX2
MATS SM FUSE F 2.0A 32V 2A ~

G7501 Top E 7 NKG3176B_H1.0
VCTCXO 38.4MHZ 2.5V
2MA 38.4MHz ~

G7502 Top E 6 VCO_DCS02733
VCO 3296-3980MHZ 4-
BAND MATSUSHITA

3296-398
0MHz ~

G9400 Top C 6 BATTER_RB414H
RTC CAPACITOR 15UAH
2.6/3.3V 414-SIZE 3V3 ~

L1000 Top E 15 0603_BLM
FERR.BEAD 220R/100M
1.5A 0R07 0603

220R/
100MHz ~

L2000 Top D 3 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2001 Bot C 7 0405_2_MATSU
CHIP BEAD ARRAY
2X1000R 0405

2x1000R/
100MHz ~

L2030 Bot C 6 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L2031 Bot C 7 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L2032 Bot C 6 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L2033 Bot C 6 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L2034 Bot D 5 0402L_XL
CHIP COIL 68N J
Q17/300M 0402 68nH ~
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L2152 Bot F 4 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2153 Bot F 4 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2154 Bot G 4 COIL_LK_1608
CHIP COIL 390N K
Q15/25MHZ 0603 390nH ~

L2155 Bot J 4 COIL_LK_1608
CHIP COIL 390N K
Q15/25MHZ 0603 390nH ~

L2156 Top E 14 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L2167 Bot H 5 COIL_LK_1608
CHIP COIL 390N K
Q15/25MHZ 0603 390nH ~

L2168 Bot I 5 COIL_LK_1608
CHIP COIL 390N K
Q15/25MHZ 0603 390nH ~

L2170 Top E 4 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L4200 Top D 13 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L4201 Top C 15 0603_BLM
FERR.BEAD 220R/100M
2A 0R05 0603

220R/
100MHz ~

L4203 Top E 13 CHOKE_SER400
INDUCT WW 4.7UH M
1.15A 0R12 4X4X1.8 4u7H ~

L4205 Top E 15
CHOKE_SER300_H1
.5

CHOKE 4U7 0.86A 0R2
3X3X1.5 4u7H ~

L4850 Top I 15 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L5250 Bot F 7 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

L6300 Bot F 12 CHOKE_SER300
INDUCT WW 2.2UH 1A2
0R168 310 CASE SIZE 2u2H ~

L6451 Bot B 12 0402L_W065_POL
CHIP COIL 3N9 +-0N1
Q28/1GHZ 0402 3n9H ~

L6452 Bot B 12 0402L_H0.45
CHIP COIL 2N4 +-0N1
Q35/1GHZ 0402 2n4H ~

L7400 Top I 8 0402L
CHIP COIL 22N0 H
Q22/250MHZ 0402 22nH ~

L7515 Top F 4
CHOKE_SER300_H1
.5

CHOKE 3U3 1.2A 0R096
3X3X1.5 3u3H ~

L7516 Top G 6 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~
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Item Side Grid ref. Type Description and value

L7518 Top J 6
FERRITE_FBMJ160
8

FERRITE BEAD 0R01
28R/100MHZ 0603

28R/
100MHz ~

L7520 Top E 5 COIL_HK_1608 CHIP COIL 470NH J 0603 470nH ~

L7521 Top F 6 0402L
CHIP COIL 100N J
Q16/300M 0402 100nH ~

L7654 Top H 6 0402L
CHIP COIL 6N8 J
Q27/800M 0402 6n8H ~

L7655 Top H 7 0402L
CHIP COIL 10N J
Q30/800M 0402 10nH ~

L7656 Top I 4 0402L_W065_POL
CHIP COIL 3N9 +-0N1
Q28/1GHZ 0402 3n9H ~

L7657 Top F 4
FERRITE_FBMJ160
8

FERRITE BEAD 0R01
28R/100MHZ 0603

28R/
100MHz ~

L7659 Top I 5 0402L
CHIP COIL 22N J
Q28/800M 0402 22nH ~

L7660 Top J 4 0402_ELJRF
CHIP COIL 47N J
Q6/100M 0402 47nH ~

L8700 Top I 14 0402L
FERRITE BEAD 0R25
120R/100MHZ 0402

120R/
100MHz ~

L8720 Bot D 15 CHOKE_SER400
INDUCT WW 4.7UH M
1.15A 0R12 4X4X1.8 4u7H ~

L8903 Bot H 13 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L8904 Bot I 11 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L8910 Bot G 12 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L8911 Bot H 11 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L8990 Bot J 11 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L9900 Bot K 11 COIL_LPS3015
CHIP COIL 220UH M 9R5
0A15 3X3X1.5 220uH ~

L9902 Bot G 11 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

L9928 Bot G 3 0402L_H0.45
CHIP COIL 3N3 +-0N1
Q30/1GHZ 0402 3n3H ~

L9929 Top J 5 0402L
CHIP COIL 1N2 +-0N3
Q34/800M 0402 1n2H ~

L9930 Bot F 3 0402_ELJRF
CHIP COIL 47N J
Q6/100M 0402 47nH ~
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Item Side Grid ref. Type Description and value

L9931 Bot F 3 0402_ELJRF
CHIP COIL 47N J
Q6/100M 0402 47nH ~

L9933 Top F 8 0402L_H0.45
CHIP COIL 3N3 +-0N1
Q30/1GHZ 0402 3n3H ~

M2150 Bot E 3
VIBRA_M_KHN4NX
1RA

SMD VIBRA MOTOR 1.3V
90MA 9000RPM ~ ~

N2030 Bot C 7
uBGA_6_1.45X0.9
5

TI ANALOG SWITCH
TS5A3159YZTR
WCSP06 ~ ~

N2150 Top D 11 XBGA_N8_H0.625
TI ANALOG SWITCH
SN74LVC2G66YZTR ~ ~

N4200 Top C 14 PBGA_N80

MENELAUS1 V2.2
TWL92230 S-PBGA-
N80 ~ ~

N4850 Top I 15 XBGA_N6_H0.625
TEMP SENSOR TMP105
12C IF WCSP6 ~ ~

N6030 Top C 8 LGA_BTHFM_ES3.6
BTHFM1.0 BALUN ONLY
SOLUTION ~ ~

N6300 Bot E 12
XBGA_N8_2.02X1.
02

DC/DC CONV
TPS6231YZD 1.5V CSP8 ~ ~

N6301 Bot F 13 LLP_6
REG LP3981YDX 2.8/
NOPB 0.3A LLP-6 ~ 2.8V

N6302 Bot C 11 LBWA19EBE6 WLAN SIZE3.0 MODULE ~ ~

N6303 Bot F 12 MLF_6
REG MIC5319YML
500MA ADJ MLF6 ~ ADJ

N7501 Top F 7 TFBGA_188_H1.4
PIHI N2.0 RF SYSTEM
MODULE ~ ~

N7502 Top I 7 RF9282E3.6

PA RF9282E6.5 GSM/
EDGE
850/900/1800/1900 ~ ~

N7503 Top G 4 RF9372_H1.5

PA MODULE
RF9372E5.2 WCDMA
1850-1980MHZ ~ ~

N7504 Top F 5
uBGA8_1.849X1.6
96

DC CONV LM3202TLX
NOPB REVB USMD8 ~ ~

N8200 Bot J 15 R_XBGA_N12_X

DUAL ANALOG SW
TS3DS26227 SPDT
CSP12 ~ ~

N8201 Bot J 15 R_XBGA_N12_X

DUAL ANALOG SW
TS3DS26227 SPDT
CSP12 ~ ~
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Item Side Grid ref. Type Description and value

N8701 Bot H 14 LLP_6
REG LP3981YDX-3.0
LLP3 ~ 3V

N8702 Bot I 15
USMD5_1.47X1.04
_H0.675

VREG LP3985ITLX-3.0
NOPB USMD5 ~ 3V

N8703 Bot I 14
USMD5_1.47X1.04
_H0.675

VREG LP3985ITLX-3.0
NOPB USMD5 ~ 3V

N9100 Top B 11
IRDA_TFBS_GP2W_
CIM IRDA MIR XSMALL ~ ~

N9101 Top G 10 CEBBO2P_576
CEBBO2P RAP3GS PA
128+128 ~ ~

N9900 Bot K 12 DFN_10
ELDRIVE D381B 2-7V
DFN-10 ~ ~

N9901 Top D 12
USMD5_1.47X1.04
_H0.675

VREG LP3985ITLX-3.0
NOPB USMD5 ~ 3V

N9904 Top C 13 LFCSP14
ACCELEROMETER 3-AXIS
2.5V LGA14 ~ ~

R1000 Bot F 8 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R1001 Bot F 8 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R1003 Top E 15 0402R Resistor 5% 63mW 150R ~

R1010 Bot G 7 0402R
Chipres 0W06 jumper
0402 0R ~

R1011 Bot G 6 0402R
Chipres 0W06 jumper
0402 0R ~

R1012 Bot G 6 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2007 Bot C 8
uBGA_10_1.7X2.0
5

ASIP USB2 FILTER
BGA10**PBFREE** ~ ~

R2010 Top C 3 BGA_4 ASIP TVS BGA4 ~ ~

R2040 Bot D 8 0402R
Chipres 0W06 100k F
200ppm 0402 100k ~

R2041 Bot D 7 0402R
Chipres 0W06 100k F
200ppm 0402 100k ~

R2042 Bot D 7 0402R
Chipres 0W06 100k F
200ppm 0402 100k ~

R2043 Bot D 7 0402R
Chipres 0W06 100k F
200ppm 0402 100k ~

R2046 Bot D 6 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~
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Item Side Grid ref. Type Description and value

R2048 Bot C 5 0402R
Chipres 0W06 jumper
0402 0R ~

R2049 Bot C 5 0402R
Chipres 0W06 jumper
0402 0R ~

R2050 Bot C 5 0402R
Chipres 0W06 jumper
0402 0R ~

R2051 Bot D 8 0402R Resistor 5% 63mW 220k ~

R2060 Bot E 8 uBGA5
ASIP 4XESD **PB-
FREE** BGA5 ~ ~

R2061 Top I 13 0603R Resistor 5% 63mW 68R ~

R2062 Top I 13 0402R
CHIPRES 0W06 2R2 J
0402 2R2 ~

R2063 Top I 13 0402R
CHIPRES 0W06 2R2 J
0402 2R2 ~

R2064 Bot C 8 0402R Resistor 5% 63mW 100k ~

R2068 Bot D 9 0402R Resistor 5% 63mW 10R ~

R2070 Bot F 5 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2071 Bot G 10 0402_NTH5
NTC RES 47K J B=4050
+-3% 0402 47k ~

R2072 Bot D 4 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2074 Bot C 9 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2075 Bot D 7 0402R Resistor 5% 63mW 22R ~

R2076 Bot D 7 0402R Resistor 5% 63mW 22R ~

R2153 Top E 15 uBGA8_1.47X1.47
ASIP SIM INTERFACE
**LOW CAP**BGA8 ~ ~

R2154 Bot I 4 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2155 Bot I 4 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R2165 Top D 11 0402R Resistor 5% 63mW 10k ~

R2166 Top E 4 0402_VAR
CHIP VARISTOR
VWM15V VC50V 0402 15V/50V ~

R4800 Top F 13 0402R Resistor 5% 63mW 10R ~

R4801 Top F 15 0402R Resistor 5% 63mW 2k2 ~

R4802 Top F 15 0402R Resistor 5% 63mW 2k2 ~

R4804 Top C 11 0402R Resistor 5% 63mW 100k ~
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Item Side Grid ref. Type Description and value

R5002 Top I 12 0402R Resistor 5% 63mW 100k ~

R5004 Top I 13 0402R Resistor 5% 63mW 100k ~

R5050 Top H 16 0402R Resistor 5% 63mW 100k ~

R5060 Top I 12 0402R Resistor 5% 63mW 100k ~

R5063 Top I 13 0402R Resistor 5% 63mW 100k ~

R6109 Top C 7 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

R6120 Top B 7 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

R6121 Top C 9 0603_BLM
FERRITE BEAD 0R5
600R/100MHZ 0603

600R/
100MHz ~

R6162 Top B 7 0402R Resistor 5% 63mW 100k ~

R6196 Top C 7 0402R Resistor 5% 63mW 220R ~

R6303 Bot E 12 0402R
CHIPRES 0W06 150K F
200PPM 0402 150k ~

R6304 Bot E 11 0402R
CHIPRES 0W06 270K F
200PPM 0402 270k ~

R6305 Bot E 11 0402R Resistor 1% 63mW 12k ~

R6306 Bot F 11 0402R Resistor 5% 63mW 1M0 ~

R6440 Bot C 10 0402R Resistor 5% 63mW 1M0 ~

R6491 Bot E 10 0402R Resistor 5% 63mW 10k ~

R7504 Top I 8 0402R
CHIPRES 0W06 27K F
0402 27k ~

R7505 Top G 4 0402R
Chipres 0W06 47k F
200ppm 0402 47k ~

R7510 Top H 5 0402R Resistor 5% 63mW 10k ~

R7512 Top E 7 0402R Resistor 5% 63mW 22k ~

R7513 Top H 6 0402R Resistor 5% 63mW 4k7 ~

R7516 Top E 7 0402R
CHIPRES 0W06 1K0 F
200PPM 0402 1k0 ~

R7517 Top E 7 0402R
CHIPRES 0W06 8K2 F
0402 8k2 ~

R7524 Top E 5 0402R
CHIPRES 0W06 1K2 F
250PPM 0402 1k2 ~

R7528 Top E 6 0402R
Chipres 0W06 5R6 J
0402 5R6 ~

R7531 Top E 5 0402R Resistor 5% 63mW 82R ~

R7621 Top G 4 0402R Resistor 5% 63mW 10R ~
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Item Side Grid ref. Type Description and value

R8523 Top E 16 0402_VAR
CHIP VARISTOR
VWM15V VC50V 0402 15V/50V ~

R8700 Bot D 13 0402R Resistor 5% 63mW 1M0 ~

R8701 Bot E 15 0402R Resistor 5% 63mW 10k ~

R8720 Bot D 13 0402R Resistor 5% 63mW 10k ~

R8723 Bot D 13 0805R
CHIPRES 0W125 10R F
0805 10R ~

R8724 Bot D 14 0402R Resistor 5% 63mW 150R ~

R8726 Bot D 14 0402R Resistor 5% 63mW 10k ~

R8727 Bot D 14 0402R Resistor 5% 63mW 150R ~

R8728 Bot E 16 0402R Resistor 5% 63mW 1k0 ~

R8729 Bot F 16 0402R Resistor 5% 63mW 1k0 ~

R8732 Top I 12 0402R
Chipres 0W06 100R F
200ppm 0402 100R ~

R8733 Top I 12 0402R
Chipres 0W06 100R F
200ppm 0402 100R ~

R8748 Bot D 13 0402R Resistor 5% 63mW 10k ~

R8751 Top B 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R8800 Top F 15 0402R Resistor 5% 63mW 100k ~

R8801 Top K 12 0805R
CHIPRES 0W1 3M3 J
0805 3M3 ~

R8902 Bot K 11 0402R Resistor 5% 63mW 100k ~

R8903 Bot K 10 0402R Resistor 5% 63mW 100k ~

R8920 Bot H 11 0402_VAR
CHIP VARISTOR
VWM15V VC50V 0402 15V/50V ~

R8921 Bot H 12 0402_VAR
CHIP VARISTOR
VWM15V VC50V 0402 15V/50V ~

R8922 Bot I 12 0402_VAR
CHIP VARISTOR
VWM15V VC50V 0402 15V/50V ~

R8923 Bot G 11 0402_VAR
CHIP VARISTOR
VWM15V VC50V 0402 15V/50V ~

R8925 Bot I 12 0402_VAR
CHIP VARISTOR
VWM15V VC50V 0402 15V/50V ~

R8932 Top I 12 0402R
Chipres 0W06 jumper
0402 0R ~

R8933 Top I 12 0402R
Chipres 0W06 jumper
0402 0R ~
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R8940 Bot H 12 0402_VAR
CHIP VARISTOR
VWM15V VC50V 0402 15V/50V ~

R8941 Bot J 13 0402R Resistor 5% 63mW 10k ~

R8942 Bot K 10 0402R Resistor 5% 63mW 10k ~

R8949 Bot G 13 0402R Resistor 5% 63mW 100k ~

R9077 Bot G 8
FLIP_CHIP_16_2.01
X2.02_H0.715

MMC ASP HIGH SPEED
BGA16 ~ ~

R9102 Top C 11 0805R
CHIPRES 0W125 4R7 J
0805 4R7 ~

R9105 Top C 11 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R9133 Top H 4 0402R
Chipres 0W06 jumper
0402 0R ~

R9404 Top D 9 0402R Resistor 5% 63mW 470k ~

R9406 Top H 8 0402R Resistor 5% 63mW 3k3 ~

R9407 Top H 8 0402R Resistor 5% 63mW 3k3 ~

R9408 Top F 8 0402R
Chipres 0W06 jumper
0402 0R ~

R9900 Bot K 13 0402R Resistor 5% 63mW 82k ~

R9923 Top I 8 0402R
Chipres 0W06 jumper
0402 0R ~

R9927 Bot F 3 0402R
Chipres 0W06 jumper
0402 0R ~

R9928 Top I 5 0402R Resistor 5% 63mW 47R ~

R9931 Top D 5 0402R
Chipres 0W06 jumper
0402 0R ~

R9932 Top I 6 0404_RAC10
RES NETWORK 0W04
1DB ATT 0404

870R/
5R77/870
R ~

T7501 Top H 6 TRANS_LDB15
TRANSF BALUN 2134
+-90MHZ 0805 ~ ~

T7502 Top E 7
TRANS_HHM1517A
2

TRANSF BALUN 3800
+-550MHZ 0805 ~ ~

V6300 Bot F 11 SC79
SCH DI 1PS79SB31
200MA 30V SOD523 ~ ~

V6301 Bot F 11 SC79
SCH DI 1PS79SB31
200MA 30V SOD523 ~ ~

V8720 Bot D 14 VMT3
TR 2SC5658QRS N 50V
0A1 0W15 VMT3 ~ ~

RM-156
Parts Lists and Component Layouts Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 2 –25
Copyright © 2007 Nokia. All rights reserved.

 



Item Side Grid ref. Type Description and value

V8725 Bot C 15 SMINI_3
MFET N 25V 1A 0R55
VGS12V SOT323 ~ ~

V8726 Bot C 15
SMINI_2_F2_TUMD
2

SCH DI MA21D35 30V/
1A VF=0.49V/1A ~ ~

V8727 Bot B 15
LED_LNJ0F0C7FRA
9

LED FLASH
LNJ0F0C7FRA 25MA ~ ~

V8730 Top B 15 LED_CL_270

LED CL270HR RED
>5MCD@20MA
90'0603 ~ ~

V8731 Bot E 14 SMINI_3
MFET N 25V 1A 0R55
VGS12V SOT323 ~ ~

X2000 Top B 3
CON_JACK_HR33NK
_2DJA_2S

CONN DC-JACK 2.0MM
3POL SPR 90DEG ~ ~

X2001 Bot B 7
SYSCON_MQ202_N
K_14R3

SM SYSTEM CONNECTOR
14POL ~ ~

X2060 Bot J 5
TRACEABILITY_PA
D

MODULE ID
COMPONENT
2.8X1.8X0.3 ~ ~

X2070 Bot E 4
CON_BATT_2_1705
771_5

CONN BATT 3.5V 2A
P3.7 ~ ~

X2750 Bot G 15
SIM_CONN_C707_1
0M006_140_2

CONN SM SIM 6POL
P2.54 H5.0 ~ ~

X5250 Bot I 8
CONN_DM2B_DSF
W_PEJ

MINISD CONN DM2B-
DSFW-PEJ-N 125V 0.5A ~ ~

X6402 Bot B 14
SPRING_WN9149_
N10

C-SPRING ANTENNA
active ~ ~

X6403 Bot B 13
SPRING_WN9149_
N10

C-SPRING ANTENNA
active ~ ~

X6405 Bot C 10
RF_SWITCH_MS_15
6

SM RF SWITCH MS156
DNS05952 HDC13 ~ ~

X7605 Bot F 2
SPRING_WN9149_
N10

C-SPRING ANTENNA
active ~ ~

X7610 Bot G 2
SPRING_WN9149_
N10

C-SPRING ANTENNA
active ~ ~

X8500 Top K 12
SPRING_DMD1248
2

UI SPRING DMD12482-
EN ~ ~

X8501 Top J 12
SPRING_DMD1248
2

UI SPRING DMD12482-
EN ~ ~

X8700 Bot F 16
CON_JAE_FI_J25S_V
F15

CONN COAX 25PIN
RECEPT VERTICAL 50V
0.3A ~ ~
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X8902 Bot H 12
CON_JAE_FI_J25S_V
F15

CONN COAX 25PIN
RECEPT VERTICAL 50V
0.3A ~ ~

X9005 Bot G 3
RF_SWITCH_MS_15
6

SM RF SWITCH MS156
DNS05952 HDC13 ~ ~

X9006 Bot H 10
CON_JAE_FI_J30S_V
F15

CONN COAX 30POL F
VERTICAL 50V 0.3A P0.4 ~ ~

X9900 Top F 16
MOLEX_SD_51338_
0409

SM CONN B2B 2X20 F
P0.4 ~ ~

Z2000 Bot C 9 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

Z2001 Bot C 9 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

Z2003 Bot C 9 FERRITE_0402
FERRITE BEAD 0.6R
600R/100MHZ 0402

600R/
100MHz ~

Z2030 Bot D 6 BGA11
ASIP 4 LINES AUDIO
FILTER BGA11 ~ ~

Z7501 Top H 4 P_TC3N_12_1_AGI

DUPL BAW
1920-1980/2110-2170
MHZ 3.8X3.8

1920-198
0/2110-2
170MHZ ~

Z7503 Top H 7
MODULE_SP_LMZ_1
37_H1.35

TX SAW MODULE GSM
850/900MHZ

850/900
MHz ~

Z7600 Top I 6 FILTER_LFTC10N
CER FILT LFL181699TC1
2400-2480MHZ 1.6

2400-248
3MHz ~

Z8801 Top G 16
uBGA25_2.47X2.4
7

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z8802 Top D 16
uBGA25_2.47X2.4
7

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z8900 Bot H 13
uBGA25_2.47X2.4
7

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z8901 Bot I 13
uBGA25_2.47X2.4
7

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z8902 Bot J 10
uBGA25_2.47X2.4
7

ASIP 10-CH ESD EMI
FILTER BGA25 ~ ~

Z9064 Bot G 14 uBGA5
ASIP 4XESD **PB-
FREE** BGA5 ~ ~

Z9065 Top J 5 CQF12_N2
RF SWITCH SP3T
850/1800/1900MHZ

880-960/
1710-199
0MHz ~
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Engine PWB component layouts

Figure 2 Component layout - Bottom (1UV_060a)
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Figure 3 Component layout - Top (1UV_060a)
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UI PWB component parts list

Table 9 Component parts list 1UX_030a

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS). To ensure you are always
using the latest codes, please check the PWS on a daily basis.

Item Side Grid ref. Type Description and value

C1 Top L 10 0402C_H0.6
CHIPCAP X5R 100N M 16V
0402 100n 16V

N1 Top L 11 SENSOR_MR10
MAGNETO RESISTIVE
SENSOR MRUS71D SOT4 ~ ~

R19 Top L 11 0402_VAR
CHIP VARISTOR VWM15V
VC50V 0402 15V/50V ~

S26 Top M 15
SWITCH_EVQQ7
GC50 5-WAY JOYSTICK ~ ~

S27 Top M 13 SWITCH_EVQP6E
SM DOME SWITCH DC 15V
20MA ~ ~

S28 Top M 12 SWITCH_EVQP6E
SM DOME SWITCH DC 15V
20MA ~ ~

X1 Top F 18
MOLEX_SD_5590
9_0473 SM CONN B2B 2X20M P0.4 ~ ~
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UI PWB component layout

Figure 4 Component layout - Top (1UX_030a)
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Flip PWB component parts list

Table 10 Component parts list 1UY_0301a

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS). To ensure you are always
using the latest codes, please check the PWS on a daily basis.

Item Side Grid ref. Type Description and value

C12 Top G 13 0402C Chipcap 5% NP0 27p 50V

C15 Top G 14 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C16 Bot R 13 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C17 Top P 13 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C18 Top P 13 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

C19 Top P 13 0402C Chipcap 5% X7R 560p 50V

C6 Top I 16 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C7 Top I 17 0603C
CHIPCAP X5R 1U K 6V3
0603 1u0 6.3V

C8 Top G 13 0402C
CHIPCAP X5R 100N K
10V 0402 100n 10V

L3 Top Q 15 0405_2_MATSU
CHIP BEAD ARRAY
2X1000R 0405

2x1000R/
100MHz ~

N1 Top G 14 SOT908_1
COVER LED DRIVER
PCA9633 HVSON8 ~ ~

R1 Bot S 17 0402_NTH5
NTC RES 47K J B=4050
+-3% 0402 47k ~

R10 Top Q 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~

R11 Top I 13 0402R
Chipres 0W06 100R F
200ppm 0402 100R ~

R12 Top I 13 0402R Resistor 5% 63mW 33R ~

R13 Top I 13 0402R Resistor 5% 63mW 33R ~

R16 Top Q 18 0402L
FERRITE BEAD 0R25
120R/100MHZ 0402

120R/
100MHz ~

R17 Top Q 18 0402R
Chipres 0W06 jumper
0402 0R ~

R2 Bot R 17 0402R Resistor 5% 63mW 470k ~

R3 Bot S 17 0402R Resistor 5% 63mW 100k ~

R9 Top Q 15 0402_VAR
CHIP VARISTOR
VWM14V VC50V 0402 14V/50V ~
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Item Side Grid ref. Type Description and value

S1 Bot S 12 SWITCH_EVQP6E
SM DOME SWITCH DC
15V 20MA ~ ~

S2 Bot S 18 SWITCH_EVQP6E
SM DOME SWITCH DC
15V 20MA ~ ~

S3 Top D 17
DETECTOR_ESE2
3J101XDL

SM SW DETECTOR 5.0V
0.01A ~ ~

V1 Bot S 16 TRANS_SFH3710

SILICON
PHOTOTRANSISTOR
SF3710 SMT 2.1X1.4X ~ ~

V2 Top J 15
LED_CL_502N7_S
D_T

LED GRN 125MCD 5MA
25DEG 151306 ~ ~

V3 Top I 13 VMT3
TR 2SC5658QRS N 50V
0A1 0W15 VMT3 ~ ~

X10 Top I 17
MOLEX_500024_
1609

SM CONN B2B 2X8 F
P0.4 ~ ~

X6 Bot S 13

CAMERA_MODUL
E_ST_VS6451XX
XX

CMOS CAMERA MODULE
CIF+ (384x320) ACME ~ ~

X7 Top G 11
CON_24R_JANK_
P0.4

CONN BTB 2X12 P0.4
30V 0.2A ~ ~

X8 Top G 14
CON_JAE_FI_J20S
_VF15

CONN COAX 20PIN
RECEPT VERTICAL 50V
0.3A ~ ~

X9 Top G 17
CON_JAE_FI_J30S
_VF15

CONN COAX 30POL F
VERTICAL 50V 0.3A P0.4 ~ ~
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Flip PWB component layouts

Figure 5 Component layout - Bottom (1UY_0301a)
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Figure 6 Component layout - Top (1UY_0301a)

Mic PWB component parts list

Table 11 Component parts list 1YQ_030a

Note: For Nokia product codes, please refer to the latest Service Bulletins on the Partner Website (PWS). To ensure you are always
using the latest codes, please check the PWS on a daily basis.

Item Side Grid ref. Type Description and value

B1 Top B 9
MIC_43011_300
4710_H0.9

MIC SILICON OMNI
31100-3008062 ~ ~

B2 Top B 11
MIC_43011_300
4710_H0.9

MIC SILICON OMNI
31100-3008062 ~ ~
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Item Side Grid ref. Type Description and value

C2 Top C 9 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

C3 Top C 10 0402C_H0.6
CHIPCAP X5R 100N K
16V 0402 100n 16V

S29 Top B 10 SWITCH_EVQP6E
SM DOME SWITCH DC
15V 20MA ~ ~

X3 Top C 3
FLEX_06FHS_RSM
1_G_G

SM FPC ZIF CONN 6POL
P0.5 ~ ~

Mic PWB component layout

Figure 7 Component layout - Top (1YQ_030a)
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 Phoenix installation steps in brief

Prerequisites
Recommended hardware requirements:

• Computer processor: Pentium 700 MHz or higher

• RAM 256 MB

• Disk space 100-300 MB

Supported operating systems:

• Windows 2000 Service Pack 3 or higher

• Windows XP Service Pack 1 or higher

Context
Phoenix is a service software for reprogramming, testing and tuning phones.

Phoenix installation contains:

• Service software support for all phone models included in the package

• Flash update package files for programming devices

• All needed drivers for:

• PKD-1 (DK2) dongle

• DKU-2 USB cable

Note: Separate installation packages for flash update files and drivers are also available, but it is
not necessary to use them unless there are updates between Phoenix service software releases. If
separate update packages are used, they should be used after Phoenix and data packages have been
installed.

The phone model specific data package includes all changing product specific data:

• Product software binary files

• Files for type label printing

• Validation file for the faultlog repair data reporting system

• All product specific configuration files for Phoenix software components

Note: Phoenix and phone data packages should only be used as complete installation packages.
Uninstallation should be made from the Windows Control Panel.

To use Phoenix, you need to:

Steps
1. Connect a PKD-1 (DK2) dongle to the computer parallel port.

2. Install Phoenix.

3. Install the phone-specific data package.

4. Configure users.

5. Manage connection settings (depends on the tools you are using).

• Update FPS-10 software

Note: There is no need to activate FPS-10.

• Activate SX-4 smart card, if you need tuning and testing functions.

Note: When FPS-10 is used only for product software updates, SX-4 smart card is not needed.
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Results
Phoenix is ready to be used with FPS-10 flash prommer and other service tools.

 Installing Phoenix

Prerequisites
• Check that a dongle is attached to the parallel port of your computer.

• Download the Phoenix installation package (for example, phoenix_service_sw_2004_39_x_xx.exe) to your
computer (in C:\TEMP, for instance).

• Close all other programs.

• Depending on your operating system, administrator rights may be required to install Phoenix.

• If uninstalling or rebooting is needed at any point, you will be prompted by the InstallShield program.

Context
At some point during the installation procedure, you may get the following message:

Figure 8 Dongle not found

This may be a result of a defective or too old PKD-1 dongle.

Check the COM/parallel ports used. After correcting the problem, you can restart the installation.

For more detailed information, please refer to Phoenix Help files.

Tip: Each feature in Phoenix has its own Help function, which can be activated while running the
program. Press the F1 key or the feature’s Help button to activate a Help file.

Steps
1. To start the installation, run the application file (for example,phoenix_service_sw_2004_39_x_xx.exe).

2. In the Welcome dialogue, click Next.
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3. Read the disclaimer text carefully and click Yes.

Figure 9 Disclaimer text

4. Choose the destination folder.

The default folder C:\ProgramFiles\Nokia\Phoenix is recommended.

5. To continue, click Next.

To choose another location, click Browse (not recommended).

6. Wait for the components to be copied.

The progress of the installation is shown in the Setup Status window.

7. Wait for the drivers to be installed and updated.

The process may take several minutes to complete.

If the operating system does not require rebooting, the PC components are registered right away.

If the operating system requires restarting your computer, the Install Shield Wizard will notifies about it.

Select Yes... to reboot the PC immediately or No... to reboot the PC manually afterwards.

After the reboot, all components are registered.

Note: Phoenix does not work, if the components have not been registered.
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8. To end the installation, click Finish.

Figure 10 InstallShield Wizard Complete

Next actions
After the installation, Phoenix can be used after:

• installing phone model specific data package for Phoenix
• configuring users and connections

FPS-10 flash prommer can be used after updating their flash update package files.

 Updating Phoenix installation

Context
• If you already have the Phoenix service software installed on your computer, you need to update the

software when new versions are released.

• To update Phoenix, you need to follow the same steps as when installing it for the first time.

• When you are updating, for example, from version a14_2004_16_4_47 to a15_2004_24_7_55, the update
will take place automatically without uninstallation.

• Always use the latest available versions of both Phoenix and the phone-specific data package. Instructions
can be found in the phone model specific Technical Bulletins and phone data package readme.txt files
(shown during installation).

• If you try to update Phoenix with the same version you already have (for example, a15_2004_24_7_55 to
a15_2004_24_7_55), you are asked if you want to uninstall the existing version. In this case you can choose
between a total uninstallation or a repair installation in a similar way when choosing to uninstall the
application from the Windows Control Panel.

• If you try to install an older version (for example, downgrade from a15_2004_24_7_55 to
a14_2004_16_4_47), installation will be interrupted.
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Figure 11 Installation interrupted

• Always follow the instructions on the screen.

Steps
1. Download the installation package to your computer hard disk.

2. Close all other programs.

3. Run the application file (for example, phoenix_service_sw_2004_39_x_xx.exe).

Results
A new Phoenix version is installed and driver versions are checked and updated.

 Uninstalling Phoenix

Context
You can uninstall Phoenix service software manually from the Windows Control Panel.

Steps
1. Open the Windows Control Panel, and choose Add/Remove Programs.
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2. To uninstall Phoenix, choose Phoenix Service Software→Change/Remove→Remove .

Figure 12 Remove program

The progress of the uninstallation is shown.

3. If the operating system does not require rebooting, click Finish to complete.

Figure 13 Finish uninstallation
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If the operating system requires rebooting, InstallShield Wizard will notify you. Select Yes... to reboot the
PC immediately and No... to reboot the PC manually afterwards.

 Repairing Phoenix installation

Context
If you experience any problems with the service software or suspect that files have been lost, use the repair
function before completely reinstalling Phoenix.

Note: The original installation package (for example, phoenix_service_sw_a15_2004_24_7_55.exe)
must be found on your PC when you run the repair setup.

Steps
1. Open Windows Control Panel→Add/Remove Programs .

2. Choose Phoenix Service Software→Change/Remove .

3. In the following view, select Repair.

Figure 14 Repair program

Phoenix reinstalls components and registers them.

The procedure is the same as when updating Phoenix.

4. To complete the repair, click Finish.

 Phone data package overview
Each product has its own data package (DP). The product data package contains all product-specific data files
to make the Phoenix service software and tools usable with a certain phone model.

The phone data package contains the following:

• Product software binary files
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• Files for type label printing

• Validation file for the fault log repair data reporting system

• All product-specific configuration files for Phoenix software components

Data files are stored in C:\Program Files\Nokia\Phoenix (default).

 Installing phone data package

Prerequisites
• A phone-specific data package contains all data required for the Phoenix service software and service tools

to be used with a certain phone model.

• Check that a dongle is attached to the parallel port of your computer.

• Install Phoenix service software.

• Download the installation package (for example, XX-XX_dp_EA_v_1_0.exe) to your computer (for example,
in C:\TEMP).

• Close all other programs.

(XX-XX = type designator of the product)

If you already have Phoenix installed on your computer, you will need to update it when a new version is
released.

Note: Often Phoenix and the phone-specific data package come in pairs, meaning that a certain
version of Phoenix can only be used with a certain version of a data package. Always use the latest
available versions of both. Instructions can be found in phone-specific Technical Bulletins and
readme.txt files of data packages.

Steps
1. To start the installation, run the application file (for example, XX-XX_dp_EA_ v_1_0.exe),

Wait for the installation files to be extracted.
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2. Click Next.

3. In the following view you can see the contents of the data package. Read the text carefully. There is
information about the Phoenix version required with this data package.

Figure 15 Data package setup information

4. To continue, click Next.
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5. Choose the destination folder, and click Next to continue.

Figure 16 Data package destination folder

The InstallShield Wizard checks where Phoenix is installed, and the directory is shown.

6. To start copying the files, click Next.
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Phone model specific files are installed. Please wait.

7. To complete the installation, click Finish.

Figure 17 InstallShield Wizard Complete

Next actions
Phoenix can be used for flashing phones and printing type labels after:

• Configuring users

• Managing connections

FPS-10 can be used after updating their flash update package files.

 Uninstalling phone data package

Context
There is no need to uninstall an older version of a data package, unless instructions to do so are given in the
readme.txt file of the data package and bulletins related to the release.

Please read all related documents carefully.

Steps
1. Locate the data package installation file (e.g. XX-XX_dp_EA_v_1_0.exe) from your computer.

2. To start the uninstallation procedure, double-click the data package installation file.
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3. To uninstall the data package, click OK or to interrupt the uninstallation, click Cancel.

Figure 18 Uninstalling phone data package

4. When the data package is uninstalled, click Finish.

Figure 19 Finishing data package uninstallation

Alternative steps
• You can also uninstall the data package manually from

Control Panel→Add/Remove Programs→xx-xx* Phone Data Package . (*= type designator of the
phone).
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 Configuring users in Phoenix

Steps
1. Start Phoenix service software, and log in.

Figure 20 Phoenix login

If the user ID is already configured, select s/he from the User name drop-down list, and click OK.

2. To add a new user, or to edit existing ones, click Maintain.

3. To add a new user, click New.

4. Type in the name and initials of the user, and click OK.

The user is added to the user name list.

5. Select the desired user from the User name drop-down list, and click OK.

Figure 21 New user configured

 Managing connections in Phoenix

Context
With the Manage Connections feature you can edit and delete existing connections or create new ones.

Note: After choosing the desired connection, and connecting the phone to a PC for the first time,
allow the PC to install the USB device drivers first. Please note that this may take some time to
complete.

If there are problems after the driver installation, check that the USB connection is active from the
Windows Control Panel. If the problem persists, contact the local PC support.

Steps
1. Start Phoenix, and log in.

2. Choose File→Manage Connections... .
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3. To add a new connection, click Add.

4. Select Manual mode, and click Next to continue.

If you want to create the connection using the Connection Wizard, connect the tools and a phone to your
PC. The wizard will automatically try to configure the correct connection.

Figure 22 Select mode: Manual

i For an FPS-10 flash prommer with a USB Connection, choose the following connection settings:

• Media: FPS-10 USB

• DEVICE_INDEX: 0

• SERIAL_NUM: See Serial No from the label attached to the bottom of FPS-10

• ACTIVE_MEDIA: USB

ii For an FPS-10 flash prommer with a LAN connection, choose the following connection settings:

• Media: FPS-10 TCP/IP

• NET_SERV_NAME: Click Scan.... Choose your own FPS-10 device based on the correct MAC address.
See Serial No from the label attached to the bottom of your FPS-10.

• PORT_NUM: Use the default value, and click Next.

• PROTOCOL_FAMILY: Use the default value, and click Next.

• SOCKET TYPE: Use the default value, and click Next.

• TX_BUFFER_SIZE: Use the default value, and click Next.

• RX_BUFFER_SIZE: Use the default value, and click Next.

iii For a plain USB connection, choose the following connection settings:

Note: First connect the DKU-2 USB cable between the PC USB port and phone.

• Media: USB

5. To complete the configuration, click Finish.
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6. Click the connection you want to activate. Use the up/down arrows located on the right hand side to move
it on top of the list, then click Apply.

Figure 23 Connections list

The connection is activated, and it can be used after closing the Manage Connection window.

The connection information is shown at the right hand bottom corner of the screen.

Figure 24 Connection information

7. To use the connection, connect the phone to your PC with correct service tools. Make sure the phone is
switched on, and then choose File→Scan Product .

Results
The product support module information appears in the status bar:

Figure 25 Product support module information (example from RM-1)

 Installing flash support files for FPS-10

Prerequisites
Note: You need to install flash support files for FPS-10 only, if you don’t have the latest Phoenix
available or the flash support files have changed after the latest Phoenix release.

• Flash support files are installed automatically, when you install Phoenix. Use Phoenix packages later than
June 2006.

• Normally it is enough to install Phoenix and the phone-specific data package because the Phoenix
installation always includes the latest flash update package files for FPS-10.

• A separate installation package for flash support files is available, and the files can be updated according
to this instruction, if updates appear between new Phoenix / data package releases

Context
If you are not using a separate installation package, you can skip this section and continue with  "Updating
FPS-10 flash prommer software" (page 3–22) after installing a new phone data package.
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Steps
1. To begin installation, double- click flash_update_x_yy.exe .

Figure 26 Flash update welcome dialog

If the same version of Flash Update package already exists, and you want to reinstall it, the previous
package is first uninstalled. Restart installation again after that.

2. If you try to downgrade the existing version to older ones, the setup will be aborted. If you really want
to downgrade, uninstall newer files manually from Control Panel and then rerun the installation again.

Figure 27 Flash installation interrupted

If an older version exists on your PC and it needs to be updated, click Next to continue installation.
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3. It is highly recommended to install the files to the default destination folder C:\Program Files\Nokia
\Phoenix. Click Next to continue.

Figure 28 Flash destination folder

When installing the flash update files for the first time you may choose another location by selecting
Browse. However, this is not recommended.
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4. To complete the installation procedure, click Finish .

Figure 29 Finish flash update

Next actions
FPS-10 flash prommers must be updated using Phoenix!

 Updating FPS-10 flash prommer software

Steps
1. Start Phoenix Service Software and log in, manage connection correctly for your flash prommer.

2. Choose Flashing→Prommer maintenance .

3. When the new flash update package is installed to the computer you will be asked to update the files to
your Prommer. To update the files, click Yes. Click OK if the computer informs you about an unsafe removal
of the device.

4. Alternatively you can update the FPS-10 flash prommer software by clicking the Update button.
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5. Wait until you are notified that update has been successful; the procedure will take a couple of minutes.
Click OK to close the Update Done window.

Figure 30 Prommer SW update finished

6. If you are using the FPS-10 flash prommer, check that it is detected from the progress info. Check also the
status leds in the FPS-10. The MODE2 led (green), VBAT and POWER leds (red) should be lit. If you are using
LAN connection, the LAN led (yellow) should be blinking.

7. Check that your FPS-10 flash prommer has enough memory. Flashing the SU-18 with FPS-10 needs at least
128 MB of SRAM memory in the prommer.

Figure 31 Prommer maintenance window
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Alternative steps
• You can update FPS-10 SW by clicking the Update button and selecting the appropriate fpsxupd.ini file in

C:\Program Files\Nokia\Phoenix\Flash.

Figure 32 Flash directory window

• All files can be loaded separately to the prommer used. To do this, click the right mouse button in the
Flash box files window and select the file type to be loaded.

More information can be found in Phoenix Help.
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 New service tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-156, refer to various concepts.

FS-22 Flash adapter

Flash adapter FS-22 is used for phone testing and flashing.

FS-22 is used with the generic flash adapter base SS-60/62 and control
Unit CU-4 or interface adapter SS-46. When flashing or system testing
the phone, the adapter is attached to replace the phone own battery.

All functions (as well as the calibration voltages, current and the
protections for over voltages, over current and voltage polarity), are
performed by CU-4.

Flash adapter FS-22 main features:

• VBATT supply interface

• USB / FBUS multiplexed interface to the phone

• Supply voltage for light source

MJ-95 Module jig

MJ-95 is meant for component level troubleshooting.

The jig includes an RF interface for GSM, WCDMA, Bluetooth and WLAN.
In addition, it has the following features:

• Provides mechanical interface with the engine module

• Provides galvanic connection to all needed test pads in module

• Multiplexing between USB and FBUS media, controlled by Vusb

• UI test interface

• SD interface

• Duplicated SIM connector

• Audio components: IHF, MIC, earpiece

• Connector for control unit

• Access for Pop-PortTM system connector

RJ-110 Rework jig

RJ-110 is a rework jig used with ST-43.
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SA-118 RF coupler

SA-118 is used for RF testing with FS-22, SS-62 and CU-4.

SS-107 Window removal
tool

SS-107 is used for removing sub LCD window assy without
disassembling the phone.

 General service tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-156, refer to various concepts.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-10 or FPS-11 to a PC. It is
included in the FPS-10 and FPS-11 sales packages.

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.

CA-53 USB connectivity
cable

USB to system connector cable.
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CA-58RS RF tuning cable

RF tuning cable for use with a flash adapter.

CA-58RS RF cable extends adapter features to allow RF function tests
and RF tuning in GSM bands.

Features include:

• easy to use together with flash adapter or even stand alone

• most accurate RF connection to phone module under test

• most accurate RF connection to phone module under test

• low attenuation and small “ripple” over the width of each GSM band

Note: The RF cable must be used for RF tuning.

CA-64U Video-out cable

CA-64U is used to check TV-out functionality.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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DAU-9S MBUS cable

The MBUS cable DAU-9S has a modular connector and is used, for
example, between the PC's serial port and module jigs, flash adapters
or docking station adapters.

Note: Docking station adapters valid for DCT4 products.

FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable

JXS-1 RF shield box

Because the WCDMA network disturbs the RX side testing of the WCDMA
phone and the Tx signal of the WCDMA phone can severely disturb the
WCDMA network, a shield box is needed in all testing, tuning and fault
finding which requires WCDMA RF signal.

The shield box is not an active device, it contains only passive filtering
components for RF attenuation.
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PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled operating voltage.

PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.

SB-6 Bluetooth tester

The SB-6 test box is a generic device to perform Bluetooth bit error
rate testing and doing cordless FBUS connection via Bluetooth.

SB-7 WLAN test box

WLAN test requires defined position for the device.
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SRT-6 Opening tool

SRT-6 is used to open phone covers and B-to-B connectors.

SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SS-93 Opening tool

SS-93 is used for opening JAE connectors.

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.
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XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.

XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB

 Non-standard service tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-156, refer to various concepts.

PC TV card

A PC TV card can be used for testing the TV-out functionality. The
minimum requirements for a TV card are the following:

• Video formats:

• NTSC and PAL input support

• Physical inputs:

• female inputs

• composite video input

• RCA Audio input or an input adaptable to RCA using a converter
cable (e.g. 3.5 mm input)

Different devices are available from various vendors, and can be used
without special approval from Nokia.
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Standard TV set

A standard TV set is used for testing the TV-out functionality of the
device. A commercial colour TV set with compatible video formats
(NTSC or PAL) can be used in service centers.

Different devices are available from various vendors, and can be used
without special approval from Nokia.

 Service concepts

POS (Point of Sale) flash concept

Figure 33 POS flash concept

Type Description

Product specific tools

BL-5F Battery

Other tools

FLS-4S POS flash dongle

PC with Phoenix service software
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Type Description

Cables

CA-53 USB connectivity cable

CU-4 flash concept with FPS-10

Figure 34 CU-4 flash concept with FPS-10

Type Description

Product specific tools

FS-22 Flash adapter

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card

PC with Phoenix service software

Cables

PCS-1 Power cable

XCS-4 Modular cable
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Type Description

Standard USB cable

USB cable

Module jig service concept

Figure 35 Module jig service concept

Type Description

Phone specific tools

MJ-95 Module jig

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SX-4 Smart card

PC with Phoenix service software

Measurement equipment

Cables

PCS-1 DC power cable
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Type Description

XCS-4 Modular cable

XRS-6 RF cable

USB cable

GPIB control cable

RF testing concept with RF coupler

Figure 36 RF testing concept with RF coupler

Type Description

Product specific tools

FS-22 Flash adapter

SA-118 RF coupler

Other tools

CU-4 Control unit

SX-4 Smart card

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

Measurement equipment
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Type Description

PC with Phoenix service software

Cables

PCS-1 Power cable

XCS-4 Modular cable

XRS-6 RF cable

GPIB control cable

USB cable

Service concept for RF testing and RF/BB tuning

Figure 37 Service concept for RF testing and RF/BB tuning

Type Description

Product specific tools

MJ-95 Module jig

Other tools

CU-4 Control unit

SX-4 Smart card

Measurement equipment
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Type Description

Smart card reader

PC with Phoenix service software

Cables

DAU-9s MBUS cable

PCS-1 DC power cable

PKD-1/PK-1 SW security device

XRS-6 RF cable

GPIB control cable

USB cable

Flash concept with FPS-10, SS-62 and SB-7

Figure 38 Flash concept with FPS-10, SB-7 and JBT-9

Type Description

Product specific tools

FS-22 Flash adapter

Other tools

CU-4 Control unit

FPS-10 Flash prommer box
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Type Description

PKD-1/PK-1 SW security device

SB-7 WLAN test box

SS-62 Flash adapter base

SX-4 Smart card

PC with Phoenix service software

Cables

XCS-4 Modular cable

PCS-1 Power cable

USB cable

LAN connection flash concept
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Type Description

Product specific tools

FS-22 Flash adapter

Other tools

FPS-10 Flash prommer box

PKD-1 SW security device

SS-46 Interface adapter

Cables

CA-35S Power cable

XCS-4 Modular cable

LAN cable

TV-out testing concept
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Type Description

Product specific tools

FS-22 Flash adapter

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card

Cables

CA-64U Video-out cable

PCS-1 Power cable

USB cable

Standard USB cable
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 Lower block disassembly
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 Baseband troubleshooting

Troubleshooting flow
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 Dead or jammed device troubleshooting

Troubleshooting flow
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 General power checking troubleshooting - CMT

Troubleshooting flow
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 General power checking troubleshooting - APE

Troubleshooting flow
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 CMT clocking troubleshooting

Troubleshooting flow
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 APE clocking troubleshooting

Troubleshooting flow
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 Application processor troubleshooting

Troubleshooting flow
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 Charging troubleshooting

Troubleshooting flow
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 Battery current measuring fault troubleshooting

Troubleshooting flow
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 Flash programming fault troubleshooting

Troubleshooting flow
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 CMT SDRAM memory fault troubleshooting
CMT SDRAM memory is located in the CeBBo2P module. If there is a fault in the CMT SDRAM memory, the device
is beyond economical repair.
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 CMT NOR flash memory fault troubleshooting
CMT NOR flash memory is located in the CeBBo2P module. If there is a fault in the CMT NOR flash memory, the
device is beyond economical repair.
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 Application processor memory troubleshooting

Troubleshooting flow
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 APE temperature sensor troubleshooting

Troubleshooting flow
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 TV-out troubleshooting

Troubleshooting flow
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 Power key troubleshooting

Troubleshooting flow
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 USB interface troubleshooting

Troubleshooting flow
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 SIM card troubleshooting

Troubleshooting flow
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 MiniSD troubleshooting

Troubleshooting flow
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 Irda troubleshooting

Troubleshooting flow
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 WLAN interface troubleshooting

Troubleshooting flow
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 Keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

1 One or more keys are stuck, so that the key(s) does not react when you press a keydome. This kind of
failure is caused by mechanical reasons (dirt, corrosion).

2 Malfunction of several keys at the same time; this happens when one or more rows or columns are failing
(shortcut or open connection). For a more detailed description of the keyboard and keymatrix, see section
Keyboard.

If the failure mode is not clear, start with the Keyboard Test in Phoenix.
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Troubleshooting flow
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 Mode switch troubleshooting

Troubleshooting flow
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 FM radio troubleshooting

Troubleshooting flow
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 Certificate restoring for BB5 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-8 or FPS-10.

Note: USB flashing does not work for a dead BB5 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2004.39.7.70 or newer.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

• External smart card reader

Note: The smart card reader is only needed when FPS-8 is used. FPS-10 has an integrated smart card
reader.

• Activated FPS-8 flash prommer OR FPS-10 flash prommer

• Flash update package 03.18.004 or newer for FPS-8 or FPS-10 flash prommers

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-8 or FPS-10.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→SW Update  and wait until Phoenix reads the product data as shown in the following
picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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 Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• Display is in a partial idle mode when the phone is in the screen saver mode.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 12 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 13 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect counts R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be
interpreted as combined dot defect.
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Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Verify that there is no coaxial cable breakage by disconnecting the coaxial cable from the display side and
the engine side and replacing it with a working cable.

If the display works, there is a coaxial cable breakage, if not, proceed to the next step.

4. Proceed to the display troubleshooting flowcharts.

Use the Display Test tool in Phoenix to find the detailed fault mode.
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Main display troubleshooting

Troubleshooting flow
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Display backlight troubleshooting

Troubleshooting flow

Keyboard backlight troubleshooting

Context
Keyboard backlight is achieved by EL driver on the engine board and EL sheet on the top cover (over keymat ).

Keyboard backlight is turned ON only in dark conditions. This is controlled by ambient Light Sensor (ALS).

ALS and keyboard backlight can be enabled/disabled with the help of Phoenix Service Software.
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Troubleshooting flow

Enabling/disabling keyboard backlights in Phoenix

Steps
1. Open Phoenix service software.

2. Choose File Scan Product.

3. Choose Testing→Display Test .

Display Test window appears.
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4. Click the Lights tab to access the keyboard backlight menu .

5. From the Target drop-down menu, choose Keyboard backlight.

6. Check the state as ON and click Write.

7. To switch the keyboard backlight off, check state as OFF and click Write.

ALS troubleshooting

Context
• If a phototransistor is broken, replace it with a typical phototransistor.

• After replacing the phototransistor or if calibration values are lost for some other reason, ALS re-tuning is
required.

• Before starting the ALS calibration procedure, perform the 'Pull-up resistor calibration' in dark lighting
conditions, and write the measured 'correction' value to the phone. After this ALS calibration procedure
is performed, and the default co-efficient value '1' is written to the phone.

• Make sure that you have completed Display and keypad backlight troubleshooting first before
starting ALS troubleshooting.

Here are some hints for ALS troubleshooting; the following troubleshooting diagram refers to these:

• Phoenix LED control tool also shows you luminance. The correct luminance in darkness is <20 lx, and in
office environment 100-2000 lx. The luminance value depends strongly on the light source and the angle
of the phone, so these values are only a rough guideline.

• LED driver control voltage measurement points can be found from the LED driver troubleshooting
section. When backlight brightness is set to 100%, both GENOUT signals are low, and enable PWM is 100%.

• Phoenix has an ambient light sensor calibration tool for changing calibration values. The pull-up resistor
calibration is done first. See the following procedure.
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Steps
1. Cover the light guide (upper part of the A-Cover).

2. Start Phoenix.

3. Choose File→Scan Product.

4. Choose Tuning→Ambient Light Sensor Calibration.

Figure 39 Ambient Light Sensor Calibration window

5. In the Pull Up Resistor Calibration pane, click Start, and Write.

6. In the Ambient Light Sensor Calibration pane, check the Use default values only check box, and click
Write.

7. To end the calibration, click Close.
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Troubleshooting flow
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Cover LED troubleshooting

Troubleshooting flow
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Adjusting LCD and keyboard backlights in Phoenix

Context
• The sub display doesn't use backlight; the illumination mode is self-emissive lightning. Phoenix allows

the display luminance to be set to two different levels (100cd/m2 or 20cd/m2).

• The keyboard backlights can be turned on only when the main LCD backlight is on.

• The brightness level of the keyboard backlights follow the brightness of the main LCD backlight.

• It takes 30 seconds to change the LCD backlight on/off status after clicking the Write button. If you need
to turn on/off the backlight quickly, use the Level field to turn on (100%)/off (0%) the backlight.

Steps
1. Open Phoenix service software.

2. Choose File→Scan Product.

3. Choose Testing→Display Test.

Display Test window appears.

4. To access the light control menu, click the Lights tab.

5. From the Target drop-down menu, choose the test target: Display, Display2, Keyboard.

Display = main display

Display2 = sub display.

You can also change the backlight status to On or Off from the State drop-down menu.
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6. Click Write.

The selected test target can now be controlled. You can control the brightness by using the Level slider.

Examples
1 To turn on/off the main LCD backlight, use the following settings:

• Target: Display

• State: On/Off

• Level: 100

You can turn the LCD backlight on/off by adjusting the Level value to be either 100 ( On) and 0 ( 0ff).

2 To set the maximum or minimum luminance in the sub LCD, use the following settings:

• Target: Display2

• State: On/Off

• Level: 100 cd/m2 or 20 cd/m2

No other intermediate level is allowed.

3 To turn on/off the keyboard backlight, use the following settings:

• Target: Keyboard

• State: On/Off

• Level: 100

Note: The main LCD backlight has to be on in advance.

 Bluetooth troubleshooting

Introduction to Bluetooth troubleshooting
There are two main Bluetooth problems that can occur:

Problem Description

Detachment of the Bluetooth antenna. This would most likely happen if the device has
been dropped repeatedly to the ground. It could
cause the Bluetooth antenna to become loose or
partially detached from the PWB. (see the following
pictures for details on BT antenna HW and
mechanics)

Malfunction in the Bluetooth ASIC, BB ASICs or
Phone’s Bluetooth SMD (Surface Mounted Device)
components.

This is unpredictable and could have many causes,
i.e. SW or HW related.

The main issue is to find out if the problem is related to the BT antenna or related to the Bluetooth system
or the phone’s BB and then replace/fix the faulty component.
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Figure 40 Bluetooth antenna location

Figure 41 Bluetooth antenna module
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Figure 42 Bluetooth location on PWB
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Figure 43 Bluetooth circuitry and test points

Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Place the phone to a flash adapter in the local mode.

4. Choose Testing→Bluetooth LOCALS .

5. 5. Locate JBT-9 BT boxe’s BT Device Address (12-digits) in the type label on the back of BT box.

In addition to JBT-9, also SB-6, JBT-3 and JBT-6 Bluetooth test boxes can be used.

6. In the Bluetooth LOCALS window, write the 12-digit BT Device Address on the
Counterpart BT Device Address line.

This needs to be done only once provided that JBT-9 is not changed.

7. Place the JBT-9 box near (within 10 cm) the BT antenna and click Run BER Test.

Results
Bit Error Rate test result is displayed in Bit Error Rate (BER) Tests pane in the Bluetooth LOCALS window within
a couple of seconds.
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Figure 44 BER test result

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.

2. ChooseFile→Scan Product.

3. Place the phone to a flash adapter.

4. From the Mode drop-down menu, set mode to Local.

5. Choose Testing→Self Tests.

6. In the Self Tests window check the following Bluetooth related tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST
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7. To run the tests, click Start.

Figure 45 Bluetooth self tests in Phoenix
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Bluetooth troubleshooting

Troubleshooting flow
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Bluetooth Bit Error Rate failure troubleshooting

Troubleshooting flow
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BT audio failure troubleshooting

Troubleshooting flow

 Audio troubleshooting

Audio troubleshooting test instructions
Differential external earpiece and internal earpiece outputs can be measured either with a single-ended or
a differential probe.

When measuring with a single-ended probe each output is measured against the ground.
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Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also that when using a current probe, the input signal
frequency must be set to 2 kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope

• Function generator (sine waveform)

• 'Active speaker' or 'speaker and power amplifier'

• Sound level meter

• Current probe (Internal handsfree DPMA output measurement)

• Phoenix service software

• Battery voltage 3.7 V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be
activated:

• External microphone to Internal earpiece

• External microphone to Internal handsfree speaker

• Internal microphone to External earpiece

• Digital stereo microphone to External earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test
are presented in the following table.

Phoenix audio loop tests and test results
The results presented in the table apply when no accessory is connected and battery voltage is set to 3.7 V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.
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Loop test Input terminal Output
terminal

Path gain
[dB]

(fixed)

Input
voltag

e
[mVp-

p]

Differenti
al output
voltage
[mVp-p]

Output
DC level

[V]

Outpu
t

curren
t [mA]

External Mic
in

External
Speaker out

XMICP and GND HSEAR R P,
HSEAR R N and
GND

2.9 280 390 1.25 N/A

HSEAR P, HSEAR
N and GND

XMICN and GND HSEAR R P,
HSEAR R N and
GND

HSEAR P, HSEAR
N and GND

External Mic
in

HP Speaker
out

XMICP and GND EarP and GND 6.9 140 310 1.25 N/A

EarN and GND

XMICN and GND EarP and GND

EarN and GND

External Mic
in

Internal
Handsfree
out

XMICP and GND B1 pads 11.4 150 560 0 25
mA
(calc.)

XMICN and GND B1 pads

Digital
Stereo Mic in

External
Earpiece out

Speaker HSEAR R P,
HSEAR R N and
GND

NA 100
dB SPL

NA 1.28 N/A

HSEAR P, HSEAR
N and GND

Internal Mic
in

External
Earpiece out

Speaker HSEAR R P,
HSEAR R N and
GND

N/A 100
dB SPL

N/A 1.28 N/A

HSEAR P, HSEAR
N and GND
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Measurement data

Figure 46 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.

If a special low-pass filter designed for measuring digital amplifiers is unavailable, the measurement must be performed with a
current probe and the input signal frequency must be 2kHz.

Figure 47 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.
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Figure 48 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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Digital microphone troubleshooting

Troubleshooting flow
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Figure 49 Signal waveform on data out

RM-156
BB Troubleshooting and Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 6 –65
Copyright © 2007 Nokia. All rights reserved.

 



Vibra troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 14 Calibration value limits

Parameter Min. Max.

ADC Offset -20 20

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 Introduction to RF troubleshooting
The first step in fault finding should always be a visual inspection. Carefully inspect the RF area using a
microscope, and look for solder bridges, missing components, short circuits, components that have partially
come off and other anomalies. Check capacitors to see if they are not short-circuited, and inductors if they
are not open circuits. Also check that power supply lines are not short-circuited, meaning that they are not
0Ω to ground.

All measurements should be done using:

• Multimeter for measuring voltage and resistance

• Spectrum analyzer with a high-frequency, high-impedance probe (LO / reference frequencies and RF power
levels)

• Oscilloscope (DC-voltages and low frequency signals)

Caution: Radiated Tx measurements, such as when using an RF coupler, must always be performed
inside a shielded room or box. Conducted measurements with power levels higher than 0 dBm must
also be conducted inside a shielded box, because some power will inevitably leak to the antenna.
Even low Tx power levels may disturb nearby cellular networks and cause problems to network
operators.

The cellular RF section of the phone is built around the RF module N7501. This module contains RF Tx and Rx
filters as well as an RF IC, which take care of up- and down-conversions and variable gain amplification, for
example. Other major RF components include GSM/EDGE PA , WCDMA PA, VCO , and VCTCXO. An SMPS component
is used to feed supply voltage to the WCDMA PA for optimized power efficiency. The mode switch connects
the antenna to the WCDMA or the GSM path of the RF engine.

Please note that the PAs also have a big grounding pad under the module itself. This pad works to diffuse
the heat that is generated inside the module. Because of the heat-spreading properties of this pad, ensure
that the soldering is done properly, if you replace either of the two PAs.

Because most RF semiconductors are static discharge sensitive, use ESD protection when handling the
electronic components of the phone. Ground straps and ESD soldering irons are mandatory. Some RF
components are also moisture sensitive, so they must be pre-baked prior to soldering.

The PWB also contains many discrete components, including resistors, inductors and capacitors.
Troubleshooting these components is mainly done by making sure they are properly soldered to the board.
Capacitors and resistors can be checked for shorts using an ohm-meter, but be aware that in-circuit resistance
and capacitance measurements are typically not very accurate. Also keep in mind that all measured voltages
and RF levels in the service manual are approximate figures. Especially RF levels, may vary because of
variations in measurement equipment and grounding of the RF probe.

 RF key component placement
The RF section of the phone is build around one main RF ASIC N7501.

There are also two PAs on the board: one for GSM (N7502), which contains a GSM quad-band antenna switch
module. The other PA is for WCDMA (N7503).
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Figure 50 RF key component placement - top

Components on PWB Top Side Schematics ref.

RF module N7501

WCDMA PA N7503

WCDMA SMPS N7504

WCDMA Duplexer Z7501

WCDMA Balun T7501

GSM SAW Filter Z7503

ISM Filter (ISM band =
2400-2483.5MHz)

Z7600

GSM PA N7502

VCO G7502
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Components on PWB Top Side Schematics ref.

VCO Balun T7502

VCTCXO G7501

Mode Switch Z9065

BT & FM Radio N6030

Figure 51 RF key component placement - bottom

Components on PWB Bottom
Side

Schematics ref.

WLAN N6302

WLAN Regulator, 1.5V N6300
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Components on PWB Bottom
Side

Schematics ref.

WLAN Regulator, 2.8V N6301

WLAN Regulator, 3.6V N6303

Cellular RF Connector X9005

BT / WLAN RF Connector X6405

Cellular Antenna Clips X7605, X7610

BT / WLAN Antenna Clips X6402, X6403

 Troubleshooting test point locations

Figure 52 Troubleshooting test points 1
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Figure 53 Troubleshooting test points 2
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 RF troubleshooting

Troubleshooting flow
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 RF ASIC troubleshooting

Troubleshooting flow
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Synthesizer troubleshooting

Troubleshooting flow

Synthesizer test points

Measure Location Expected Result

VCTXCO output
voltage

G7501 pin 3 38.4MHz 800 mVpp
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Measure Location Expected Result

RFCLKEXT R9922 38.4MHz 500 mVpp

VCTXCO AFC voltage C7516 1V

Measure Location

VCO G7502

 Receiver troubleshooting

Introduction to Rx troubleshooting
Rx can be tested by making a phone call or in local mode. For the local mode testing, use the Phoenix service
software.

The primary Rx troubleshooting parameter is RSSI (Received Signal Strength Indicator). For GSM RSSI
measurement, see GSM Rx chain activation for manual measurements / GSM RSSI measurement
(page 7–16), and for the same measurement in WCDMA, see WCDMA RSSI measurement (page 7–17).

In GSM, the input signal can be either a real GSM signal or a CW (Continuous Wave) signal, which is 67.771
kHz above the carrier frequency.

In WCDMA, the input signal can be either a real WCDMA signal or a CW signal, which is 1 MHz above the carrier
frequency.

For service tool usage instructions, refer to the section Service Tools and Service Concepts.

Related information
• WCDMA Rx chain activation for manual measurement (page 7–16)
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GSM receiver troubleshooting

Troubleshooting flow
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WCDMA receiver troubleshooting

Troubleshooting flow
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GSM Rx chain activation for manual measurements / GSM RSSI measurement

Context
RSSI signal measurement is the main Rx troubleshooting measurement. The test measures the strength of
the received signal.

I and Q branches can be measured separately. In GSM, the input signal can be either a real GSM signal or a
CW (Continuous Wave) signal that is 67.771 kHz above the carrier frequency.

Steps
1. Start Phoenix service software.

2. Choose Testing→GSM→RSSI Reading .

3. Set the RF signal generator for a channel frequency +67.771 kHz in CW mode with a –80 dBm signal level.

Alternatively set the cellular tester downlink channel to the appropriate channel. Make sure that the tester
is set to continuous mode, not to burst mode.

4. In the RSSI Reading window, select the appropriate band and channel.

Figure 54 RSSI Reading window

5. To start the measurement, activate GSM Rx chain, click Start.

Results
RSSI reading values of the selected band and channel are displayed. The RSSI level must be the same value
as that which is set at the signal generator (-80 dBm).

WCDMA Rx chain activation for manual measurement

Steps
1. Start Phoenix service software.

2. Choose Testing→WCDMA→Rx Control .

3. In the Rx Control window:
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Figure 55 Rx Control window

• Set AGC Mode to Algorithm.

• Set Channel to 10700.

• Set AFC Algorithm to OFF (Default = OFF).

Next actions
When settings are ready, click Start to activate them.

If settings are changed later on (for example, you give a new channel number), you will need to click Stop
and Start again.

Note: Clicking Stop also disables Tx Control if that was active!

WCDMA RSSI measurement

Prerequisites
WCDMA Rx must be activated before RSSI can be measured. See WCDMA Rx chain activation for manual
measurement (page 7–16).

Steps
1. Start Phoenix service software.

2. Choose Testing→WCDMA→Rx Power Measurement .

3. In the Rx Power Measurement window, choose the following settings:

• Mode: RSSI

• Continuous Mode
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4. To perform the measurement, click Start.

Receiver test points

Band Measure Location Expected Result

WCDMA RXQP output of RF module J7615
400mVpp, DC offset 750mV,
1MHz

WCDMA Duplexer input C9107 -35dBm @ 2140MHz

WCDMA Duplexer output L7656 -35dBm @ 2140MHz

WCDMA Vctrl1 for mode switch C9301 2.7V

WCDMA Vctrl2 for mode switch C9302 0V

GSM Vctrl1 for mode switch C9301 0V

GSM Vctrl2 for mode switch C9302 2.7V

GSM Mode switch output C9930

-70dBm @
942.4677/1842.86771/1960.0
6771MHz

GSM1800 RF module input L7655 -70dBm @ 1842.86771MHz

GSM1900 RF module input L7654 -70dBm @ 1960.06771MHz

 Transmitter troubleshooting

General instructions for Tx troubleshooting

Context
• Tx troubleshooting requires Tx operation.

• Do not transmit on frequencies that are in use.

• Transmitter can be controlled in the local mode for diagnostic purposes.

• The best diagnostic tool for GSM transmitter testing is RF Controls, and for the WCDMA transmitter testing
Tx Control.

Tx IQ tuning and Tx power tuning can be also used in some cases.

• Remember that retuning is not a repair procedure.

The first set of steps instructs how to assemble the test setup. This setup is general for all Tx troubleshooting
tasks.

Alternative steps provide specific troubleshooting instructions for Phoenix service software. The first section
is for the EGSM900/GSM1800/GSM1900 bands and the latter for WCDMA.
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Caution: Never activate the GSM or WCDMA transmitter without a proper antenna load. There should
be always 50 ohm load connected to the RF connector (antenna, RF-measurement equipment or at
least 2 watts dummy load), otherwise GSM or WCDMA PA may be damaged.

Steps
1. Connect a module jig to a computer with a DAU-9S cable or to a FPS-10 flash prommer with a modular

cable.

Make sure that you have a PKD-1 dongle connected to the computer parallel port.

2. Connect a DC power supply to a product-specific module jig.

Note: When repairing or tuning a transmitter, use an external DC supply with at least 3 A current
capability.

Set the DC supply voltage to 3.9 V.

3. Connect an RF cable between the RF connector of the product-specific module test jig and measurement
equipment or alternatively use a 50 ohms (at least 2 W) dummy load in the module test jig RF connector;
otherwise GSM or WCDMA PA may be damaged.

Note: There are three antenna connectors in the module jig:

• one for cellular

• one for Bluetooth and WLAN

Make sure that all connections are made to the correct RF connector.

Normally a spectrum analyser is used as measurement equipment.

Note: The maximum input power of a spectrum analyser is +30 dBm.

To prevent any damage, it is recommended to use 10 dB attenuator on the spectrum analyzer input.

4. Set Tx on.

i Place the phone module to the test jig and start Phoenix service software.

ii Initialize connection to the phone (with FPS-10 use FBUS when using a DAU-9S cable and a COMBOX
driver).

iii Choose File→Open Product→xx-x* (* = type designator of the phone) or File→Scan Product. .

iv From the toolbar, set Operating mode to Local.

Alternative steps
• EGSM900/GSM1800/GSM1900 troubleshooting

i Choose Testing→GSM→RF Controls.

ii In the RF Controls window:

• Choose Band: GSM900 or GSM1800 or GSM1900 (Default = GSM900).

• Set Rx/Tx channel in the following way:

• GSM900: 37

• GSM1800: 700

• GSM1900: 661

• Set Active unit to Tx (Default = Rx).

• Set Operation Mode to Burst (Default = Burst).

• Set Edge to Off (Default).

• Set Tx Data Type to All 1 (Default = All 1).

• Set Tx PA Mode to High (Default).
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• Set Tx Power Level in the following way:

• GSM900: 5 (Default = 19)

• GSM1800: 0 (Default = 15)

• GSM1900: 0 (Default = 15)

Figure 56 RF Controls window

• WCDMA troubleshooting

i Choose Testing→WCDMA→Tx Control.

ii In the Tx Control window:

• Select the Algorithm mode tab.

• Set Start level to 0 dBm (Default = 0).

• Set Step size, Step count and Sequence to 0 (Default = 0).

• In the Scrambling code pane set Code class to LONG (Default = LONG), and Code to 16 (Default =
16).

• For DPDCH  set the following values:

• Code number: 0

• Code class: 2

• Weight: 15

• For DPCCH set the following values:

• Code number: 0

• Code class: 2

• Weight: 8

• Set Channel to 9750.

• Check the DPDCH enabled check box (Default).
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Figure 57 Tx Control window

Next actions
When settings are done, click Send to enable them.

If you change the settings (e.g. give a new channel number), you need to click Stop and Send again.
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GSM transmitter troubleshooting

Troubleshooting flow
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WCDMA transmitter troubleshooting

Troubleshooting flow
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Transmitter test points

Band Measure Location Expected Result

WCDMA RF module output C9941/L9933 > -1dBm at 1950MHz

WCDMA Duplexer input R9133 21dBm @ 1950MHz

WCDMA Mode switch input C9107 21dBm @ 1950MHz

WCDMA Mode switch output C7664 21dBm @ 1950MHz

WCDMA Vcc11 supply of the PA C7587 2.24V

WCDMA Vcc12 supply of the PA C7541 3.3-4.2V (supply from VBAT)

WCDMA Vreg for PA bias C7510 2.7V

WCDMA Vcon SMPS control R7524 900mV

WCDMA Vctrl1 for mode switch C9301 2.7V

WCDMA Vctrl2 for mode switch C9302 0V

GSM Vctrl1 for mode switch C9301 0V

GSM Vctrl2 for mode switch C9302 2.7V

GSM Mode switch input C9930
32/29dBm @
897.4/1747.8/1880MHz

GSM900 RF module output R9923 0dBm

GSM1800/190
0 RF module output R9932 0dBm
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 Power amplifier (PA) and switch mode power supply (SMPS) troubleshooting

Troubleshooting flow
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 RF tunings

Introduction to RF tunings
Only perform RF tunings if:

• one or more of the RF components is changed

• A flash memory chip is changed* (*if allowed) or otherwise corrupted.

Caution: RF calibration is always performed with the help of a product-specific module jig, never
with an RF coupler. Using an RF coupler in the calibration phase results in a complete mistuning of
the RF side.

Important: After RF component changes, always use autotuning. Manual tunings are only required
in rare cases.

Cable and adapter losses
RF cables and adapters have some losses. They have to be taken into account when the phone is tuned. As
all the RF losses are frequency dependent, you have to be very careful and understand the measurement
setup.

RF autotuning

Prerequisites
For information on the recommended test set-up, refer to the corresponding information on the Partner
Website or Nokia Online.

Before you can use the autotuning feature, the GPIB driver from the GPIB card vendor must be installed and
running.

The autotune .xml file must be in a correct place: C:\Program Files\Nokia\Phoenix\products\xx-x*
\rfconf_xx-x*.xml (*= indicates the type designator of the phone, e.g. RM-1)

Context
RF autotuning is performed with the aid of a digital radio communication tester.

Autotuning covers all RF tunings that are needed to perform after RF component repairs.

Note: Do not perform RF autotuning without a proper reason. Autotuning may only be performed
after component repairs or if the RF tuning information is lost.

Steps
1. Connect the communication tester to the GPIB bus.

2. Start Phoenix service software.

3. Choose Tools→Options→GPIB Card.

4. From the Card Type drop-down menu, choose the GPIB card used, then click Start.

The name of the communication tester appears in the Listeners pane.
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5. To specify the cable loss from a module jig to the communication tester, choose Set Loss from the
Tuning menu.

6. In the Set Loss window, click the Jig tab, and select the right jig for the phone from the drop-down list.

Alternatively, you can add a new jig by clicking Add, and selecting the desired jig from the list.

7. Click the Cable tab and add the extra cable attenuation.

8. To start autotuning, choose Auto-Tune from the Tuning menu.

9. In the Auto-Tune window, click Options.

10. In the Auto-Tune options window, ensure the Enable showing of message boxes check box is checked,
and click OK.

RM-156
RF Troubleshooting and Tuning Guide Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 7 –27
Copyright © 2007 Nokia. All rights reserved.

 



11. Connect the phone cellular RF port to the communication tester, and click Tune.

12. Ignore the following message and click OK.

Results
Autotuning completed successfully! message appears.
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RF manual tuning guide

Required manual tunings after component changes
Important: After RF component changes, always use autotuning. Manual tunings are only required
in rare cases.

If, however, manual tuning is used, only relevant tunings should be performed. Refer to the following table:

Changed component Perform the following tunings

RF module, N7501 RF Channel Filter Calibration, Tx IQ Tuning, Tx Power
Level Tuning, Temperature Sensor Calibration, TX
AGC & Power Detector, Tx Band Response
Calibration, Tx LO Leakage

RF Channel Filter Calibration, Rx Calibration, Rx Band
Filter Response Compensation, Rx AGC Alignment,
Rx Band Response Calibration

Any component in the GSM Tx RF chain before the
PA

Tx IQ Tuning, Tx Power Level Tuning

Any component in the GSM Tx RF chain after the PA
or PA

Tx Power Level Tuning

Any component in the WCDMA Tx RF chain before
the PA

Tx AGC & Power Detector, Tx Band Response
Calibration, Tx LO Leakage

Any component in the WCDMA Tx or Rx chain after
the PA, power detector or PA switch mode power
supply

Tx AGC & Power Detector, Tx Band Response
Calibration, PA Detection

Any component in the GSM Rx chain Rx Calibration, RX Band Filter Response
Compensation

Any component in the WCDMA Rx chain Rx AGC Alignment, RX Band Response Calibration

VCTCXO Rx Calibration (GSM850/GSM900 band)
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System mode independent manual tunings

Rf channel filter calibration

Context
Rf channel filter calibration tunes the internal low pass filters of Rx and Tx ASICs that limit the bandwidth of
BB IQ signals.

One common calibration is made for both GSM and WCDMA.

Table 15 Rf channel filter calibration tuning limits

Min Typ Max

Tx filter 0 10 31

Rx filter 0 16 31

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→Rf Channel Filter Calibration.

3. Click Tune.

4. To save the values to the PMM (Phone Permanent Memory) area, click Write.

5. To end the tuning, click Close.

Results

Figure 58 Rf channel filter calibration typical values

PA (power amplifier) detection

Context
The PA detection procedure detects which PA manufacturer is used for phone PAs.

If a PA is changed or if the permanent memory (PMM) data is corrupted, PA detection has to be performed
before Tx tunings.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→PA Detection .
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3. Click Tune.

4. Check that the detected PA manufacturers are corresponding to the actual chips on the board.

5. To end the procedure, click Close.

Temperature sensor calibration

Context
There is a temperature sensor integrated into one of the device ASICs. The ASIC provides DC-voltage, which
is temperature dependent.

Temperature sensor calibration is done in room temperature, in which offset caused by the ASIC variation
and AD-converter are nullified.

The module is able to do this calibration by itself, no external equipment is needed.

The temperature of the module and components must be 23 +/-2 degrees.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→Temperature Sensor Calibration .

3. Click Tune.

Table 16 Temperature sensor calibration tuning limits

Min Typ Max Unit

-20 -4 20 V

4. To save the calibration values, click Write.

5. To finish the calibration, click Close.

GSM receiver tunings

Rx calibration (GSM)

Context
Rx Calibration is used to find out the real gain values of the GSM Rx AGC system and tuning response of the
AFC system (AFC D/A init value and AFC slope)

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. Choose File→Scan Product.
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4. From the Operating mode drop-down menu, set mode to Local.

5. Choose Tuning→GSM→Rx Calibration.

6. Click Start.

7. Connect the signal generator to the phone and set frequency and amplitude as instructed in the Tuning
step 1 of 3 - Rx Calibration with band EGSM900 pop-up window.

Note: The calibration uses a non-modulated CW signal. Increase the signal generator level by cable
attenuation and module jig probe attenuation!
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8. To perform the tuning, click OK.

9. Check that the tuning values are within the limits specified in the following table:

Table 17 RF tuning limits in Rx calibration

Min Typ Max Unit

GSM900

AFC Value -200 -105...62 200

AFC slope 0 122 200

RSSI0 106 107...110 114 dB

GSM1800

RSSI0 104 104...109 114 dB

GSM1900

RSSI0 104 104...109 114 dB

10. When the first values have been written to the phone memory, click Next to change to the next band.

11. To finish the tuning, go through all bands, and click Close.
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Results

Rx band filter response compensation (GSM)

Prerequisites
Rx Calibration must be performed before the Rx Band Filter Response Compensation.

Context
On each GSM Rx band, there is a band rejecting filter in front of an RF ASIC front end. The amplitude ripple
caused by these filters causes ripple to the RSSI measurement and therefore calibration is needed.

The calibration has to be repeated for each GSM band.

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. Choose File Scan Product.

4. From the Operating mode drop-down menu, set mode to Local.

5. Select GSM900 band.

6. Choose Tuning→GSM→Rx Band Filter Response Compensation.

7. From the Tuning mode drop-down menu, select Manual.
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8. Click Start.

9. Connect the signal generator to the phone and set frequency and amplitude as instructed in the Tuning
step 1 of 3 - Rx Band Filter Response Compensation for EGSM900 pop-up window.

10. To perform the tuning, click OK.
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11. Go through all 9 frequencies.

The following window appears, showing signal levels for the input frequencies:

12. Check that the tuning values are within the limits specified in the following table:

Min Typ Max Unit

GSM900

Ch. 965 / 923.26771 MHz -10 -1 5 dB

Ch. 975 / 925.26771 MHz -3 0 5 dB

Ch. 987 / 927.66771 MHz -3 0 5 dB

Ch. 1009 / 932.06771 MHz -3 0 5 dB

Ch. 37 / 942.46771 MHz -3 0 5 dB

Ch. 90 / 953.06771 MHz -3 0 5 dB

Ch. 114 / 957.86771 MHz -3 0 5 dB

Ch. 124 / 959.86771 MHz -3 0 5 dB

Ch. 136 / 962.26771 MHz -10 -1 5 dB

GSM1800

Ch. 497 / 1802.26771 MHz -10 -1 5 dB

Ch. 512 / 1805.26771 MHz -3 0 5 dB

Ch. 535 / 1809.86771 MHz -3 0 5 dB

Ch. 606 / 1824.06771 MHz -3 0 5 dB
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Min Typ Max Unit

Ch. 700 / 1842.86771 MHz -3 0 5 dB

Ch. 791 / 1861.06771 MHz -3 0 5 dB

Ch. 870 / 1876.86771 MHz -3 0 5 dB

Ch. 885 / 1879.86771 MHz -3 0 5 dB

Ch. 908 / 1884.46771 MHz -10 -1 5 dB

GSM1900

Ch. 496 / 1927.06771 MHz -10 -1 5 dB

Ch. 512 / 1930.26771 MHz -3 0 5 dB

Ch. 537 / 1935.26771 MHz -3 0 5 dB

Ch. 586 / 1945.06771 MHz -3 0 5 dB

Ch. 661 / 1960.06771 MHz -3 0 5 dB

Ch. 736 / 1975.06771 MHz -3 0 5 dB

Ch. 794 / 1986.66771 MHz -3 0 5 dB

Ch. 810 / 1989.86771 MHz -3 0 5 dB

Ch. 835 / 1994.86771 MHz -10 -1 5 dB

13. If the values are within the limits, click Next to continue with the next band.

14. Go through all bands, and click Close to end the tuning.

Results
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Rx AM suppression (GSM)
Rx AM suppression tuning is not required.

GSM transmitter tunings

Tx IQ tuning (GSM)

Context
• The Tx path branches to I and Q signals at the RF I/Q modulator. Modulator and analog hardware located

after the modulator cause unequal amplitude and phase disturbance to I and Q signal paths. Tx IQ tuning
balances the I and Q branches.

• Tx IQ tuning must be performed on all GSM bands.

Steps
1. Start Phoenix service software.

2. Choose File→Scan Product.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Tx IQ Tuning.

5. From the Band drop-down menu, choose GSM900.

6. In the Tx IQ Tuning window, set mode to Automatic.

7. Click Start.

Wait until the automatic tuning feature has finished and moved the sliders.

Values are written to the phone memory automatically.

Tuning sliders should be close to the center of the scale after the tuning and within the limits specified
in the following table.
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Table 18 Tx IQ tuning limits

Min Typ Max Unit

GSM900

I DC offset / Q DC
offset

-6 -4/4 6 dB

Ampl -1 0 1 dB

Phase 85 90 95 dB

GSM1800/GSM1900

I/Q DC -6 -0.5/0.5 6 dB

Ampl -1 0 1 dB

Phase 95 100 110 dB
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8. When the first values have been written to the phone memory, click Next to continue to the next band.

9. Go through all bands.

10. When all bands have been tuned, click Finish, and Close to end the tuning procedure.

Next actions
If the tuning values are not within the limits specified in the "Tx IQ tuning limits" table, start the procedure
again, and check the Tx IQ quality manually.

Tx power level tuning (GSM)

Context
Because of variations in the integrated circuit process and discrete component values, the actual transmitter
RF gain of each phone is different. Tx power level tuning is used to find out mapping factors called 'power
coefficients’. These adjust the GSM transmitter output power to fulfill the specifications.

In dual or triple band phones, the power level tuning is made for both high and low PA Modes (Power Amplifier
Mode) in the GSM900 band but only for high PA mode in GSM1800/GSM1900 bands

For EDGE transmission, the bias settings of the GSM PA are adjusted in order to improve linearity. This affects
the PA gain and therefore the power levels have to be aligned separately for EDGE transmission.

Tx power level tuning has to be performed on all GSM bands.

Steps
1. Connect the phone to a spectrum analyzer.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Tx Power Level Tuning.
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5. Click Start.

The current coefficients saved in the permanent memory (PM) of the terminal are shown.

6. Set the spectrum analyzer for power level tuning:

Frequency channel frequency (897.4MHz GSM900,
1747.8MHz GSM1800, 1880MHz GSM1900)

Span 200 kHz

Sweep time 3s

Trigger Video triggering: Free run

Resolution BW 3 kHz

Video BW 3 kHz

Reference level offset sum cable attenuation with module jig
attenuation

Reference level 33dBm

A power meter with a peak power detector can be also used. Remember to take the attenuations into
account!
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7. Adjust power levels 5, 15 and 19 to correspond the Target dBm column by pressing + or – keys.

Check that the coefficient values are within the limits specified in the following table.

Min Typ Max

GSM900 EDGE off

PL5 coefficient 0.45 0.626 0.73

PL15 coefficient 0.234

PL19 coefficient 0.12 0.195 0.3

GSM900 EDGE on

PL8 coefficient 0.35 0.419 0.6

PL15 coefficient 0.247

PL19 coefficient 0.12 0.204 0.3

GSM1800 EDGE off

PL0 coefficient 0.45 0.51 0.7

PL11 coefficient 0.219

PL15 coefficient 0.12 0.185 0.3

GSM1800 EDGE on

PL2 coefficient 0.35 0.394 0.6

PL11 coefficient 0.23
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Min Typ Max

PL15 coefficient 0.12 0.194 0.3

GSM1900 EDGE off

PL0 coefficient 0.45 0.482 0.7

PL11 coefficient 0.218

PL15 coefficient 0.12 0.184 0.3

GSM1900 EDGE on

PL2 coefficient 0.35 0.377 0.6

PL11 coefficient 0.23

PL15 coefficient 0.12 0.193 0.3

8. If the values are within the limits, click Next to proceed to the next band, and click Start.

9. Set Edge mode on and start tuning again. Change video averaging to 50.

10. Tune EDGE power levels to the corresponding target power levels.

Only power levels 8, 15 and 19 are tuned in GSM900, and 2, 10 and 15 in GSM1800/1900.

11. When the tuning is completed, close the Tx Power Level Tuning window.

WCDMA receiver tunings

Rx calibration (WCDMA)

Context
Rx AGC alignment tuning is used to find out the real gain values of the WCDMA Rx AGC system and converters.

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. From the Operating mode drop-down menu, set mode to Local.

3. Choose Tuning→WCDMA→Rx Calibration .
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4. Click Start and Tune.

5. Setup the signal generator to correspond the values in the Rx Calibration Step 1/3 pop-up window, click
OK and continue to steps 2/3 and 3/3.

Frequency: 2113.40MHz, 2141.00MHz, 2168.6MHz

Level: –48 dBm + cable and adapter attenuations

Modulation: FM

Deviation: 500 kHz

Modulation frequency: 50 kHz
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6. Check that each value in Tuning Results is within the limits presented in the following table.

Min Typ Max Unit

RX chain -6 1.5... 3.5 6 dB

Low freq -5 -0.7... 4.0 5

High freq -5 -0.7... 4.0 5

i If the values are acceptable, click Yes to save the results to the phone.

7. To close the Rx Calibration window, click Close.

WCDMA transmitter tunings

Tx AGC & power detector (WCDMA)

Context
Tx AGC & power detector tuning has two purposes:

• to enable the phone to select the correct TxC value accurately in order to produce the required RF level

• to enable the phone to measure its own transmitter power accurately

There are two ways to perform the tuning. For an alternative method, see Alternative steps (page 7–51).

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→WCDMA→Tx AGC & Power Detector.

3. Click Options.

4. Set the parameters as below.

5. Click Start.
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6. In the Wide Range pane, click Tune (the leftmost Tune button).

7. Set up the spectrum analyzer in the following way:

8. After setting the spectrum analyzer, click OK.

9. Measure the power levels with a marker.

Take the first measurement from 250 us after the trigger, the second after 750 us, the third after 1220
us and so on for every 500 us until the table is filled.

Note: It must be possible to measure power levels down to –68 dBm. The measured power levels
must be monotonously decreasing.

Make sure that the marker is not measuring the level of noise spikes on lower levels.
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10. Fill in the power level values (in dBm) to the Wide Range table.

11. In the Wide Range pane, click Calculate.

12. In the High Burst pane, click Tune.

13. Adjust the spectrum analyzer according to the following settings:
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14. Measure the power levels with a marker.

Take the first measurement from 250 us after the trigger, the second after 750 us, the third after 1220
us and so on for every 500 us until the table is filled.

Figure 59 High burst measurement

15. In the High Burst pane, click Calculate.

16. Check that the calculated values are within the limits specified in the following table:

Min Max

C0-high -0.5 5

C1-high -50 50

C2-high 400 900

C0-mid -0.7 0.7

C1-mid 0 50

C2-mid 400 900

C0-low -4 4

C1-low -400 440

C2-low -10000 15000
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Min Max

Det-k 100 220

Det-b 0 150

17. To save the coefficients to the phone, click Write.

18. To close the Tx AGC & Power Detector window, click Close.

19. Choose Testing→WCDMA→ Tx Control.

20. Select the Algorithm mode tab.

21. Write the target power level 25 dBm to the Start level line and check the Max power limit check box
(detector calibration check).

22. Setup the spectrum analyzer with the following settings:

Center frequency: 1950.3 MHz

Span: 0 Hz

Reference level offset: Cable attenuations + adapter attenuation

Reference level: 24 dBm or -20 dBm depending on the level
measured

Input attenuation: Automatic

Resolution bandwidth: 5 MHz

Video bandwidth: 5 MHz

Sweep time: 20 ms

Detector: RMS detector
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Average: No

Trigger: Free run

23. Click Send.

24. Measure the WCDMA output power.

It should be around 21 dBm.

25. Click RF Stop and uncheck the Max power limit check box.

26. Repeat steps 19 to 23 for levels +19, +7, 0, -20 and –40 dBm.

The measured output power may not differ more than +-2 dB from the requested value at level +19 dBm
and no more than +-4 dB on lower levels.

Remember to stop the RF before sending new data.

Alternative steps
• Measure the wide range levels normally and write down the levels that are possible to measure.

• Click Finish.

• Click Options.

• Change the first wide range DAC value to 573 and change the number of tuning steps to 21.

• Change the spectrum analyzer reference level to –20 dBm and adjust the input attenuator to the lowest
value possible.

• In the Wide Range pane, click Tune and fill in the rest of values starting from the 19th level.

Tx band response calibration (WCDMA)

Context
The purpose of this tuning operation is to calibrate the WCDMA Tx performance. It defines the power detector
and Tx frequency compensation values. However, before starting this tuning procedure, it is necessary to
carry out Tx AGC & Power Detector Calibration tuning. This is because its results will be needed for this tuning
operation.

• In the Tuning Settings pane, it is possible to edit the numbers of channels used in this tuning operation.

• If the Calibrate Detector Response check box is checked, only Tx response is calibrated. Zero is written
to the power detector compensation values block in the permanent memory (PM) of the terminal.

• Detector Calibration level shows the power level used for calibrating the power detector in this tuning
procedure.

• Tx Calibration level shows the power level used for calibrating tx frequency in this tuning procedure.

• In the Measured Power Levels pane, you can insert the dBm values read from the power meter.

• In the Tuned Values pane, the values that are stored in the permanent memory (PM) of the terminal in
Current columns are shown.

• New values are added to New column when the Calculate button is clicked.

• The Abort button aborts the tuning operation without saving the tuned values.

• The Read button reads the tuned values in the PM of the terminal, and displays them in the Tuned
Values pane in in the Current column.

Steps
1. Start Phoenix service software.

2. Choose File→Scan Product  .
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3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→WCDMA→Tx Band Response Calibration .

5. Click Start.

The current values are shown in the Tuned Values pane.

6. Click Tune.

7. Connect the power meter to the terminal, and set it to Channel Mid frequency.

8. Read the values of slot 0 and slot 1 from the power meter and enter them to Middle power level fields
in the Measured Power Levels pane.

Slot 0 is used for detector calibration and slot 1 for Tx calibration.

9. Click Next.

10. Switch the power meter to Channel Low frequency.

11. Read the values from the power meter, and enter them to Low power level fields.

12. Switch the power meter to Channel High frequency.

13. Read the values from the power meter, and enter them to High power level fields.

14. Click Next.

15. Click Calculate.

The tuned values are shown in the Tuned Values pane in the New column.

16. Check that the tuned values are within the limits presented in the following table. If they are OK, click
Yes.

RM-156
Nokia Customer Care RF Troubleshooting and Tuning Guide

Page 7 –52 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.

 



Min Max

Tx Freq Comp (the first and last
value)

-4 +4

17. To save the tuned values to the terminal, click Write.

18. Close the Tx Band Response Calibration window.

Tx LO leakage (WCDMA)

Context
The purpose of Tx LO leakage tuning is to minimize the carrier leakage of the IQ-modulator which is caused
by the DC offset voltages in the Tx IQ-signal lines and in the actual IQ modulator.

The tuning improves WCDMA Tx AGC dynamics at low power levels. A self-calibration routine selects the best
combination for internal control words in order to produce minimum LO leakage.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→WCDMA→ Tx LO Leakage .

3. Change power level value to 880.
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4. Click Tune.

5. To end the tuning, click Close.
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 Introduction to camera module troubleshooting

Background, tools and terminology
Faults or complaints in camera operation can be roughly categorised into three subgroups:

1 Camera is not functional at all; no image can be taken.

2 Images can be taken but there is nothing recognizable in them.

3 Images can be taken, and they are recognizable but for some reason the quality of images is seriously
degraded.

It is hard to measure image quality quantitatively. Even comparative measurements are difficult (comparing
two images) to perform, if the difference is small. Especially, if the user is not satisfied with his/her device's
image quality, it is fairly difficult to accurately test the device, and get an exact figure that would tell whether
the device is functioning properly.

Often subjective evaluation has to be used for finding out if a certain property of the camera is acceptable.
Some training or experience of a correctly operating reference device may be needed in order to detect what
actually is wrong.

It is easy for the user to take bad images in bad conditions. Therefore, the camera operation has to be checked
always in constant conditions (lighting, temperature) or by using a second, known-to-be good device as
reference.

Tools
Phoenix service software is not recommended for camera troubleshooting because at the moment it only
supports relatively few features of the camera functionality. Instead, use the phone's camera application for
functionality checking.

You can use camera application with the product-specific module jig.

Terms

Autofocus (AF) The camera module contains lens movement mechanics for focus
adjustment. Autofocus enables camera to take sharp images of objects
positioned between 30 cm to infinity. In the AF mode, the viewfinder image
is momentarily blurred as the camera searches for the right focus setting.

Digital Zoom A digital zoom can be described as a form of cropping the image. When
using a digital zoom, the camera enlarges the image area at the centre of
the frame and discards the outside edges of the image.

Dynamic range The ability of the camera to capture details in dark and bright areas of the
scene simultaneously.

Distortion A divergence from rectilinear projection caused by a change in
magnification with increasing distance from the optical axis of an optical
system. If the magnification increases with distance, it produces
pincushion distortion; if it decreases with distance, the effect is barrel
distortion.

Exposure time Camera modules use a silicon sensor to collect light and to form an image.
The imaging process roughly corresponds to traditional film photography,
in which exposure time means the time during which the film is exposed
to light coming through optics. Increasing the time will allow for more
light hitting the film and thus results in brighter images. The operation
principle is exactly the same with a silicon sensor.
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F-number The f-number or focal ratio of an optical system expresses the diameter of
the entrance pupil in terms of the effective focal length of the lens. The f-
number of the main camera is F3.3 at wide and F5.9 at tele.

Flare, Ghost A phenomenon of some images produced by optical systems pointed
toward bright sources of light. It is caused by the scattering, reflection, and
refraction of light in lens systems. Lenses with large numbers of elements
such as zooms tend to exhibit greater lens flare, as there are more surfaces
off which reflection can occur.

Flicker Phenomenon, which is caused by pulsating in scene lighting, typically
appearing as wide horizontal stripes in an image.

LED flash LED is used as strobe flash light. The device implements 2 in 1 type LED
flash. The LED flash can be used in flash (brighter) mode when taking still
image and in torch (darker) mode when recording video.

Mechanical shutter The camera module contains a mechanical shutter.

Night mode Night mode allows bigger analogue gain than normal mode. It is suitable
for taking pictures in low ambient light (dark) condition.

Noise Variation of response between pixels with same level of input illumination.

Optical zoom The camera module contains lens movement mechanics for up to 2.75x
zoom. Optical zoom can be used with digital zoom (up to 20x); the
maximum combined zoom ratio is 55x.

Resolution The amount of pixels in the camera sensor. In some occasions the term
resolution is used for describing the sharpness of the images.

Sensitivity The light sensitivity of the camera. In equivalent illumination conditions,
a less sensitive camera needs a longer exposure time to gather enough
light in forming a good image. Analogous to ISO speed in photographic
film.

Sharpness Good quality images are 'sharp' or 'crisp', meaning that image details are
well visible in the picture. However, certain issues, such as non-idealities
in optics, cause image blurring, making objects in picture to appear 'soft'.
Each camera type typically has its own level of performance. Image gets
softer at increased zoom ratio.

White balance mode White balance is a technical method to adapt digital cameras and video
equipment to the colour temperature of the dominant light sources in the
scene. This is done by adjusting the weighting of the output channels of
the image sensor (usually RGB), so that a white surface will again appear
white in the resulting picture for a given lighting situation.

The device supports five white balance modes (Auto, Daylight, Cloudy,
Tungsten, Fluorescent). In many cases, "Auto" mode gives best white
balance but users can choose dedicated white balance mode under
particular lighting condition

 The effect of image taking conditions on image quality
There are some factors, which may cause poor image quality, if not taken into account by the end user when
shooting images, and thus may result in complaints. The items listed are normal to camera operation and
are not a reason for changing the camera module.
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Distance to target
The lens in the module is specified to operate satisfactorily from 30 cm to infinite distance of scene objects.
In practice, the operation is such that close objects may be noticed to get more blurred when distance to
them is shorter than 30 cm. The lack of sharpness is first visible in full resolution images. If observing just
the viewfinder, even very close objects may seem to appear sharp. This is normal; do not change the camera
module.

Figure 60 Blurred image. Target too close.

The amount of light available
In dim conditions camera runs out of sensitivity. The exposure time is long (especially in the night mode)
and the risk of getting shaken (= blurred) images increases. In addition, image noise level grows. The
maximum exposure time is 1/12 seconds. Therefore, images need to be taken with extreme care and by
supporting the phone when the amount of light reflected from the target is low. Because of the longer
exposure time and larger gain value, noise level increases in low light conditions. Sometimes blurring may
even occur in daytime, if the image is taken very carelessly. Examples of carelessness are handshake
introduced by handshake or by shutter button pressing operation. Strength against handshake or shutter
button operation depends on product concepts. See the figure below for an example. This is normal; do not
change the camera module.

Figure 61 Blurring caused by shaking hands
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Movement in bright light
If an image is taken of moving objects or if the device is used in a moving vehicle, object 'skewing' or 'tilting'
may occur. This phenomenon is fundamental to most CMOS camera types, and usually cannot be avoided.
The movement of camera or object sometimes cause blurring indoors or in dim lighting conditions because
of long exposure time. This is normal; do not change the camera module.

Figure 62 Near objects get skewed when taking images from a moving vehicle

Temperature
High temperatures inside the mobile phone cause more noise to appear in images. In the worst case, some
colors of image completely change. For example, in +70 degrees (Celsius), the noise level may be very high,
and it further grows if the conditions are dim. If the phone processor has been heavily loaded for a long time
before taking an image, the phone might have considerably higher temperature inside than in the
surrounding environment. This is also normal to camera operation; do not change the camera module.

Figure 63 Noisy image taken in +70 degrees Celsius

Phone display
If the display contrast is set too dark, the image quality degrades: the images may be very dark depending
on the setting. If the display contrast is set too bright, image contrast appears bad and "faint". This problem
is solved by setting the display contrast correctly. This is normal behaviour; do not change the camera module.
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Basic rules of photography
Because of dynamic range limitations, taking images against bright light might cause either saturated image
or the actual target appear too dark. In practice, this means that when taking an image indoors and having,
for example, a window behind the object, the result is usually poor. Sometimes level of exposure is a
preference issue: e.g. overexposed is preferred to take pictures of human to reproduce their face brighter.
This is normal behavior; do not change the camera module.

Figure 64 Image taken against light

Flicker
In some occasions a bright fluorescent light may cause flicker in the viewfinder and captured image. This
phenomenon may also be a result, if images or video are taken indoors under the mismatch of 50/60 Hz
electricity network frequency. The electricity frequency used is automatically detected by the camera module
in video mode or specified by the end-user in still mode. In some very few countries, both 50 and 60 Hz
networks are present and thus probability for the phenomenon increases. Flickering occurs also under high
artificial illumination level. For example, in taking scenes containing PC monitor or high illuminating object
based on electrical frequency, not only the brigtheness but also white balance would be drifted and perceived
as flickers. This is normal behavior; do not change the camera module.

Figure 65 Flicker in an image; object illuminated by strong fluorescent light
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Bright light outside of image view
Especially the sun can cause clearly visible lens glare phenomenon and poor contrast in images. This happens
because of undesired reflections inside the camera optics. Generally this kind of reflections are common in
all optical systems. In some occasions, incoming light through optics to image sensor are reflected at the
microlens on the image sensor, which causes colored reflections like grape. This is normal behavior; do not
change the camera module.

Figure 66 A lens reflection effect caused by sunshine

Examples of good quality images

Figure 67 Good image taken indoors
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Figure 68 Good image taken outdoors

 Main camera construction
This section describes the mechanical construction of the main camera module.

Table 19 Main camera specifications

Sensor type 1/3.2" MOS sensor

Sensor valid pixels 2048 x 1536 (3M)

F number/Aperture F3.3 (wide) / F5.9 (tele)

Focal length 4.5 mm (wide) / 12.4 mm (tele) 34.25 - 94.1 mm (35
mm equivalent)

Focus range 10/30 cm to infinity (tele/wide)

Still image resolutions 3Mpixels: 2048 x 1536 (print - high)

2Mpixels: 1600 x 1200 (print - standard)

1.3Mpixels: 1280 x 960 (e-mail)

VGA: 640 x 480 (MMS)

Video 640 x 480 to 128 x 96

Video frame rate 30 fps
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Figure 69 Main camera mechanics

The camera module as a component is not a repairable part, meaning that the components inside the module
will not be changed. Cleaning dust from the front face is allowed only. Use clean compressed air.

The camera module uses a socket type connecting. For versioning, laser marked serial numbering is used on
the side of the lens housing.

The main parts of the module are:

• 1/3.2" 3M sensor

• Two actuators for AF and optical zoom lens movement

• Lens interface IC

• Camera DSP

• Parallel to CCP1 converter IC

• 25-pin micro coaxial connector

• EEPROM: storage for lens characteristic data

• Shield can

 Sub camera construction

Table 20 Sub camera specifications

Sensor type 0.18um CMOS sensor

Sensor valid pixels 384 x 320 (123 thousand)

F number F2.8

Focus range 30cm to infinity

Still image
resolutions

352 x 288
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Video resolution 352 x 288

Video frame rate 30fps

Figure 70 Sub camera mechanics

The sub camera is an SMD component, that set on the Flip FPC. This is a reflowable component, so it is possible
to change it by reflow, But an easy way to change it is to use a new flip FPC.

 Image quality analysis

Possible faults in image quality
When checking for possible errors in camera functionality, knowing what error is suspected significantly
helps the testing by narrowing down the amount of test cases. The following types of image quality problems
may be expected to appear:

• Dust (black spots)

• Lack of sharpness

• Bit errors

In addition, there are many other kinds of possibilities for bad image quality, but those are ruled out from
the scope of this document since the probability of their appearance is small.

Testing for dust in camera module

Symptoms and diagnosis
For detecting dust problems, take an image of a uniform white surface and analyse it in full resolution. A
good quality PC CRT monitor is preferred for analysis (avoid using LCD). Search carefully because finding these
defects is not always easy. Figure "Effects of dust on optical path" is an example of an image having easily
detectable dust problems.
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When taking a white image, use uniformly lightened white paper or white wall. Another option is to use
uniform light but in this case make sure that the camera image is not flickering when taking the test image.
In case flickering occurs, try to reduce the illumination level. Use JPEG image format for analysing, and set
the image quality parameter to ‘High Quality’.

Black spots in an image are caused by dirt particles trapped inside the optical system. Clearly visible and
sharp edged black dots in an image are typically dust particles on the image sensor. These spots are searched
for in the manufacturing phase, but it is possible that the camera body cavity contains a particle, which may
move onto the image sensor active surface, for example, when the phone is dropped. Therefore it is also
possible that the problem will disappear before the phone is brought to service. The camera should be
replaced if the problem is present when the service technician analyses the phone.

If dust particles are lying on the infrared filter surface on either side, they are hard to locate because they
are out of focus, and appear in the image as large, grayish and fading-edge 'blobs'. Sometimes they are
invisible to the eye, and the user probably does not notice them at all. However, it is possible that a larger
particle disturbs the user, causing need for service.

Figure 71 Effects of dust on optical path

If large dust particles get trapped on top of the lens surface in the cavity between the camera window and
the lens, they will cause image blurring and poor contrast. If dust stays on the camera module surface, camera
cussion, camera bezel or window at assembling, dust may sneak into the optical system as the optical zoom
or Auto focus lens moves back and forth. The camera cussion and bezel between the window and the lens
unit or camera module should prevent any particles from getting into the cavity after the manufacturing
phase.

If dust particles are found on the sensor, this is classified as a manufacturing error of the module, and the
camera should be replaced. Any particles inside the cavity between the protection window and the lens have
most probably been trapped there in the assembly phase at a Nokia factory. Unauthorized disassembling of
the product can also be the root of the problem. However, in most cases it should be possible to remove the
particle(s) by using clean compressed air. Never wipe the lens surface before trying compressed air; the
possibility of damaging the lens is substantial. Always check the image sharpness after removing dust.

Testing camera image sharpness

Symptoms and diagnosis
If pictures taken with a device are claimed to be blurry, there are five possible sources for the problem:

1 The protection window is fingerprinted, soiled, dirty, visibly scratched or broken.

2 The camera module has failed to focus correctly, producing a blurred image.

RM-156
Nokia Customer Care Camera Module Troubleshooting

Page 8 –14 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.

 



3 User has tried to take pictures containing their intended objects, and the images are blurred or not focused
in their intended object. Auto focus is calculated in the center of the image and locked by a half press of
the shutter button. If the focus is not locked at the user's intended object, the object in the reproduced
image is blurred or not focused well. This is not a cause to replace camera module.

4 Sharpness of the images are different depending on the zoom ratio and sharpness in the image is different
depending on the location (center to corners), which is a nature of lens unit productions and controlled
within a reasonable variations. This is not a cause to replace camera module.

5 User has tried to take pictures and images are blurred due to handshake, shutter button pressing, dark
conditions or carelessness.

6 There is dirt between the protection window and the camera lens.

7 The protection window is defective. This can be either a manufacturing failure or caused by the user. The
window should be changed.

A quantitative analysis of sharpness is very difficult to conduct in any other environment than optics
laboratory. Therefore, subjective analysis should be used.

If no visible defects (items 1-4) are found, a couple of test images should be taken. Generally, a well-
illuminated typical indoor scene, such as the one in Figure "Good image taken indoors", can be used as a
target. The main considerations are:

• The camera module has to be given time to focus correctly. Correct focusing is normally indicated with a
flashing icon or green bracket in the viewfinder. During focusing, the image in the viewfinder moves
slightly back and fourth, this is normal and shows that the lens unit is moving. During the movement a
faint sound can be heard from the camera head.

• The protection window has to be clean.

• The amount of light (300 – 600 lux (bright office lighting)) is sufficient.

• The scene should contain, for example, small objects for checking sharpness. Their distance should be 1
– 2 meters.

• The focus should be locked to the object containing edges or textures by pointing the object in the center
of the image.

• If possible, compare the image to another image of the same scene, taken with a different device. Note
that the reference device has to be a similar Nokia phone.

There are several conditions in which AF operation is challenging for the camera module, i.e. failing from
time to time. These include:

• Low light scenes and night mode

• Scenes with low contrast

• Short distance to object (less than 30 cm)

• Fast-moving objects

Under low light and night mode the AF function is slower than under good light, it may even fail to find
correct focus position. Low contrast scenes or fast moving objects may also slow down or cause AF to fail.
This is normal operation, and is not a cause to replace camera.

The operation of AF can be tested by taking images of objects at different distances. Good distances are 30
cm, 60 cm and infinity (>3 m). Any LED or xenon flashes should not be used while taking the images.

The taken images should be analysed on PC screen with full screen. Pay attention to the computer display
settings; at least 65000 colours (16-bit) have to be used. 256 (8-bit) colour setting is not sufficient, and true
colour (24 bit, 16 million colours) or 32-bit (full colour) setting is recommended.

If the differences are noticeable at a glance and also if the one under investigation is significantly inferior,
the module might have a faulty lens. In this case, the module should be changed. Always recheck the
resolution after changing the camera module. If a different module produces a clearly noticeable quality gap,
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the fault is probably in the camera window. Check the window by looking carefully through it when replacing
the module. As references Figure "Good image taken indoors" and Figure "Good image taken outdoors" can
be used. Another possibility is to use a service point comparison phone, if available.

Dirty camera lens protection window
The following series of images demonstrates the effects of fingerprints on the camera protection window.

It should be noted that the effects of any dirt in images can vary much. It may be difficult to judge whether
the window has been dirty or if something else is wrong. Therefore, the cleanness of the protection window
should always be checked and the window should be wiped clean with a suitable cloth.

Figure 72 Image taken with clean protection window Figure 73 Image taken with greasy protection window

Image bit errors
Bit errors are image defects caused by data transmission errors between the camera module and the phone
baseband and/or errors inside the module.

Usually bit errors can be easily detected in images, and they are best visible in full resolution images. A good
practice is to use a uniform white test target when analysing these errors. The errors are clearly visible,
colourful sharp dots or lines in camera images. See the following figure.

Figure 74 Bit errors caused by JPEG compression

One type of bit error is a lack of bit depth. In this case, the image is almost totally black under normal
conditions, and only senses something in very highly illuminated environments. Typically this is a contact
problem between the camera module and the phone main PWB. You should check the camera assembly and
connector contacts.

If the fault is in the camera module, bit errors are typically visible only when using some specific image
resolution. For example, in case of a viewfinder fault, the error might exist but is not visible in a full size
image.
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Note: At the most 5 clusters of black dots or blemish are not considered errors, and no reason to
replace camera module

 Camera troubleshooting flowcharts

Main camera troubleshooting

Camera viewfinder troubleshooting

Troubleshooting flow
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Bad image quality troubleshooting

Troubleshooting flow
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Camera baseband HW troubleshooting

Troubleshooting flow
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Sub camera troubleshooting

Sub camera viewfinder troubleshooting

Troubleshooting flow
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Bad image quality troubleshooting

Troubleshooting flow
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Sub camera baseband HW troubleshooting

Troubleshooting flow
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 Flash LED troubleshooting

Introduction to flash LED troubleshooting
A fault or complaint associated to LED flash operation can be roughly categorized into two subgroups:

1 Flash is not functional at all (no light output at all).

2 Images can be taken and they are recognizable but for some reason the quality of images is degraded.

Examples of quality degradations:

• Brightness is not sufficient.

• Brightness is too much = overexposed.

• Only portions of the image brightness (e.g., left, right, top or bottom) are proper and the rest are not.

The quality of an image is very difficult to measure quantitatively, and even comparative measurements are
difficult (comparing two images), if the difference between reference images is small. If a user is not satisfied
with his/her device's image quality, it is fairly difficult to accurately test the device and get an exact result,
which would tell if the device is working properly.

Often subjective evaluation has to be used for finding out if there is something wrong in the flash. Some
training or experience of a correctly operating reference device may be needed in order to detect possible
faults. It is easy for a user to take low quality images in bad conditions. Therefore, the camera and flash
operation has to be always checked in constant conditions (lighting, temperature) or by using a second,
known-to-be good reference device.

Flash LED and image taking conditions
This section describes some of common factors, which may cause poor image quality if not taken into account
by end users when taking pictures, and may therefore result in complaints. The items described are normal
to the camera and LED flash operation and do not raise a need for servicing the components.

Figure 75 Example of a good quality image taken with the flash LED
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Distance to the target (too close)
There is no feedback in the flash system, which means that the light output is constant in every situation.
This causes the images to overexposure, when shot from close distance. The flash LED is designed to work
optimally between distances of 70 cm – 1.2 m.

This is normal behaviour; do not change the flash module.

Figure 76 overexposed image

Distance to the target (too far away):
The power of the white LED flash is still very modest compared to xenon flash technology. Even with full
power, the maximum distance for an acceptable image quality is roughly 1.2 m. If the distance is greater
than 1.2 m, the images will appear dark and the noise level increases.

This is normal behaviour; do not change the flash module.
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Figure 77 Dark and noisy image

Shaken (= blurred) images
The traditional xenon flash has the advantage of stopping the movement. This is a result of an extremely
short and intense light pulse, which makes it possible for a camera to use very short exposure time. Due to
the weak output of the LED flash, the exposure time has to be actually increased in the viewfinder mode in
total blackness, instead of shortening it. This allows the sensor to integrate longer and collect more light but
this also easily creates blurred images if care is not taken.

In addition to the limitation due to small LED flash light, handshake owing to camcoder type product concept
and shutter button operation exists. These are not errors but a limitation of the product. No need to change
the LED flash module.

RM-156
Camera Module Troubleshooting Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 8 –25
Copyright © 2007 Nokia. All rights reserved.

 



Figure 78 Shaken image

Camera white balance failure and overexposure due to presence of ambient light
Because the spectral output of the flash is known, the white balance and the exposure control of the camera
work in optimal way with the flash in total blackness. This is why some of the pictures may fail (i.e. images
get a bit yellow or reddish, or greenish or bluish, depending on the ambient light characteristics, as well as
overexposed or underexposed).

If the flash works correctly in dark conditions, there is no need to change the flash module.
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Figure 79 Camera white balance failure and overexposure

Colour difference between different modules
There is some variation in the spectrum of the flash, which derives from the manufacturing process of the
white LEDs. Because of this variation, there may be some variation in the colour of the images as well.

This is normal behaviour; do not change the flash module.

Figure 80 Color difference between flash colour limit samples

Flash LED overview

Table 21 Flash LED module specifications

Type White Light Emitting Diode

Material GaN
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Structure 2 chips in 1 package

Forward Voltage VF 3.4 V (typ at IFDC=20mA/chip)

Luminance
Intensity 3800 mcd (typ at IFDC=20mA/chip)

Figure 81 Flash LED mechanics

The flash LED module is not a repairable part, meaning that the components or parts in the module cannot
be changed. Only cleaning dust from the lens is allowed; use clean compressed air. The flash LED is soldered
to flex-area of the UI PWB.

The main parts of the module are:

• Housing

• Lead frame

• LED chip), which is soldered to the PWB

• Zener diode, which is ESD protection part

• Au wire

• Paste

Image quality analysis

Possible faults in image quality
When checking for possible errors in the flash functionality, knowing what error is suspected, significantly
helps the testing by narrowing down the number of possible test cases. The following types of image quality
problems may be expected to appear:

• LED module is not flashing at all

• Image colours are not good

• Flash power is weak
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Testing flash module functionality

Context
With the help of this test you can check the flash module's overall functionality.

Always set the flash to FORCED FLASH mode when performing the test. The FORCED FLASH mode enforces the
LED module to flash, even if there is some ambient light present.

Steps
1. Take an image with the flash and monitor at same time whether the LED module flashes.

Results
If the LED flashes normally, the overall functionality of the module is OK.

Testing image colours with flash

Context
With the help of this test you can check if the image colours are normal when using the flash.

Steps
1. Take an image of a target, which contains something white in total blackness from less than 1 m range.

Results
If the white target appears to be white, the flash is working correctly. However, remember that there is some
variation in the flash colour from module to module.

Testing flash power

Context
With the help of this test you can check if the flash is working with adequate power level.

Steps
1. Take an image with the flash in total blackness (ambient light <1 lux) of a target 80 cm - 1 m away.

Results
If the flash is working normally with adequate power level, the image is correctly exposed between distances
80 cm to 1 m.

Remember that the brightness level in the corners is always less than in the center of the image because of
camera and flash optics.
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Flash LED troubleshooting flowcharts

Flash LED functionality troubleshooting

Troubleshooting flow
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Flash LED baseband HW troubleshooting

Troubleshooting flow
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Red LED troubleshooting

Context
For checking the red LED functionality, force the camera application to record a video clip and monitor the
red LED at the same time. The red LED notifies video recording operation by red blinking light.

Troubleshooting flow

RM-156
Nokia Customer Care Camera Module Troubleshooting

Page 8 –32 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.

 



9  — System Module

Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 9 –1
Copyright © 2007 Nokia. All rights reserved.

 



RM-156
Nokia Customer Care System Module

(This page left intentionally blank.)

Page 9 –2 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.

 



Table of Contents
Baseband description ............................................................................................................................................9–7

System module block diagram ........................................................................................................................9–7
Baseband functional description.....................................................................................................................9–7
Application processor .......................................................................................................................................9–7
Absolute maximum ratings..............................................................................................................................9–8
Phone modes of operation...............................................................................................................................9–8
Power distribution ......................................................................................................................................... 9–10
Clocking scheme ............................................................................................................................................. 9–11
Bluetooth/FM module .................................................................................................................................... 9–12
USB................................................................................................................................................................... 9–13
WLAN interface ............................................................................................................................................... 9–14
lrda interface .................................................................................................................................................. 9–14
SIM interface ................................................................................................................................................... 9–15
MiniSD interface.............................................................................................................................................. 9–16
TV-out interface.............................................................................................................................................. 9–16
Battery interface............................................................................................................................................. 9–17
User interface.................................................................................................................................................. 9–18

Main display............................................................................................................................................... 9–18
Keyboard .................................................................................................................................................... 9–18
Display backlight ....................................................................................................................................... 9–20
Keyboard backlight ................................................................................................................................... 9–21
ALS interface .............................................................................................................................................. 9–21

ASICs................................................................................................................................................................. 9–22
Device memories ............................................................................................................................................ 9–23

RAP memories NOR flash and SDRAM ...................................................................................................... 9–23
Combo memory ......................................................................................................................................... 9–23

Audio concept ...................................................................................................................................................... 9–23
Audio HW architecture................................................................................................................................... 9–23
Internal digital MEMS microphone ............................................................................................................... 9–24
Internal analog microphone ......................................................................................................................... 9–25
External microphone...................................................................................................................................... 9–25
Internal earpiece ............................................................................................................................................ 9–25
Internal speaker ............................................................................................................................................. 9–25
External earpiece............................................................................................................................................ 9–26
SMD microphone handling ............................................................................................................................ 9–26
Vibra circuitry ................................................................................................................................................. 9–27
System connector........................................................................................................................................... 9–27

Baseband technical specifications..................................................................................................................... 9–29
External interfaces ......................................................................................................................................... 9–29
ACI interface electrical characteristics.......................................................................................................... 9–29
VOUT electrical characteristics ...................................................................................................................... 9–30
USB IF electrical characteristics..................................................................................................................... 9–30
Irda interface signals ..................................................................................................................................... 9–30
Bluetooth signal list ....................................................................................................................................... 9–31
WLAN module interface signals and supply voltages................................................................................. 9–32
FBUS interface electrical characteristics (between N2300 and Pop-Port) ................................................ 9–33
Headset hook detection interface (XMICN) electrical characteristics........................................................ 9–33
Audio signal electrical characteristics.......................................................................................................... 9–34
SIM IF connections.......................................................................................................................................... 9–34
MiniSD interface signals and supply voltages ............................................................................................. 9–35

RM-156
System Module Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 9 –3
Copyright © 2007 Nokia. All rights reserved.

 



TV-out interface signals................................................................................................................................. 9–36
Charger connector and charging interface connections & electrical characteristics .............................. 9–36
Battery connector and interface connections & electrical characteristics ............................................... 9–37
Internal interfaces.......................................................................................................................................... 9–37
UI connections ................................................................................................................................................ 9–38
Keyboard interface electrical characteristics............................................................................................... 9–38
Display interface connections ....................................................................................................................... 9–39
Camera IF connections and electrical characteristics ................................................................................. 9–40
Flash LED interface and electrical characteristics........................................................................................ 9–43
Back-up battery interface electrical characteristics.................................................................................... 9–44

RF description ...................................................................................................................................................... 9–44
Receiver ........................................................................................................................................................... 9–44

Introduction to receiver functionality .................................................................................................... 9–44
WCDMA receiver functionality .................................................................................................................. 9–45
GSM receiver functionality........................................................................................................................ 9–45

Transmitter ..................................................................................................................................................... 9–45
Introduction to transmitter functionality............................................................................................... 9–45
WCDMA transmitter functionality ............................................................................................................ 9–45
GSM transmitter functionality.................................................................................................................. 9–46

Antennas ......................................................................................................................................................... 9–46
Frequency synthesizers ................................................................................................................................. 9–48
Regulators....................................................................................................................................................... 9–48

Frequency mappings........................................................................................................................................... 9–49
EGSM900 frequencies ..................................................................................................................................... 9–49
GSM1800 frequencies..................................................................................................................................... 9–50
GSM1900 frequencies..................................................................................................................................... 9–51
WCDMA 2100 Rx frequencies ......................................................................................................................... 9–52
WCDMA 2100 Tx frequencies ......................................................................................................................... 9–53

List of Tables
Table 22 ALS resistor values ............................................................................................................................... 9–22
Table 23 Audio connector pin assignments ..................................................................................................... 9–28
Table 24 WLAN module interface signals ......................................................................................................... 9–32
Table 25 Power supplies for WLAN module...................................................................................................... 9–33
Table 26 miniSD host and card interface signals ............................................................................................. 9–35
Table 27 miniSD interface supply voltages....................................................................................................... 9–35
Table 28 Signaling interface between application processor and OPA361................................................... 9–36
Table 29 Charging interface connections ......................................................................................................... 9–36
Table 30 Charging IF electrical characteristics ................................................................................................. 9–36
Table 31 Battery interface connections ............................................................................................................ 9–37
Table 32 Battery IF electrical characteristics .................................................................................................... 9–37
Table 33 User interface connections ................................................................................................................. 9–38
Table 34 Main display connections.................................................................................................................... 9–39
Table 35 Sub display connections...................................................................................................................... 9–40
Table 36 Camera interface connections............................................................................................................ 9–40
Table 37 Camera supply voltage characteristics .............................................................................................. 9–43
Table 38 Flash LED / indicator LED interface connections ............................................................................... 9–43
Table 39 Flash LED interface electrical characteristics .................................................................................... 9–44
Table 40 Back-up battery connections.............................................................................................................. 9–44
Table 41 Back-up battery electrical characteristics ......................................................................................... 9–44

RM-156
Nokia Customer Care System Module

Page 9 –4 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.

 



List of Figures
Figure 82 System level block diagram .................................................................................................................9–7
Figure 83 Power distribution diagram ............................................................................................................. 9–10
Figure 84 Clocking scheme................................................................................................................................. 9–12
Figure 85 WLAN block diagram.......................................................................................................................... 9–14
Figure 86 Interconnections between application processor, EM ASICs, and IR module............................... 9–15
Figure 87 SIM interface ....................................................................................................................................... 9–16
Figure 88 TV-out interface block diagram ........................................................................................................ 9–17
Figure 89 Battery pin order ................................................................................................................................ 9–17
Figure 90 General diagram of the LCD module................................................................................................. 9–18
Figure 91 Keyboard layout ................................................................................................................................. 9–20
Figure 92 Main display backlight control diagram .......................................................................................... 9–20
Figure 93 Keyboard backlight block diagram................................................................................................... 9–21
Figure 94 ALS hardware implementation......................................................................................................... 9–22
Figure 95 Audio block diagram.......................................................................................................................... 9–24
Figure 96 Internal digital microphones circuitry in MicPWR key PWB........................................................... 9–24
Figure 97 Internal digital microphones circuitry in engine PWB ................................................................... 9–25
Figure 98 Internal analog microphone circuitry in engine PWB .................................................................... 9–25
Figure 99 Internal speaker circuitry in engine PWB ........................................................................................ 9–26
Figure 100 External microphone and earpieces circuitry in engine PWB...................................................... 9–26
Figure 101 Vibra circuitry ................................................................................................................................... 9–27
Figure 102 External audio connector ................................................................................................................ 9–28
Figure 103 Charger connector............................................................................................................................ 9–36
Figure 104 Battery connector ............................................................................................................................ 9–37
Figure 105 Main antenna (GSM/WCDMA)........................................................................................................... 9–47
Figure 106 Main antenna contact ...................................................................................................................... 9–47
Figure 107 Bluetooth/WLAN Antenna ............................................................................................................... 9–48
Figure 108 Bluetooth/WLAN contact ................................................................................................................. 9–48

RM-156
System Module Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 9 –5
Copyright © 2007 Nokia. All rights reserved.

 



RM-156
Nokia Customer Care System Module

(This page left intentionally blank.)

Page 9 –6 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.

 



 Baseband description

System module block diagram
The device consists of three different main modules: transceiver, UI and flip. The transceiver board consists
of baseband and RF components.

The UI board consists of key domes, key backlights, MR sensor, Power-ON switch and microphones for video
recording.

The flip board consists of main/sub displays, sub camera, LEDs for some notifications and ALS.

The connection between the UI and the transceiver board is established via a board-to-board connector. The
connection between flip and the transceiver is also established by same solution.

Note: In this description, the user interface HW covers display, camera, keyboard, keyboard
backlight and ALS.

Figure 82 System level block diagram

Baseband functional description
Digital baseband consists of an ISA (Intelligent Software Architecture) based modem and Symbian based
application sections. The modem functionality is in RAP, and the application processor acts as a platform for
Symbian applications. The terms ISA and Symbian are used refer to the software environment of these
devices.

The modem section consists of a RAP ASIC with NOR FLASH and SDRAM memory as the core. RAP supports
WCDMA and GSM cellular protocols. The modem DDR SDRAM memory has 128 Mbits of memory and NOR flash
has 128 Mbits of memory. RAP operates with the system clock of 38.4 MHz, which comes from the VCTCXO.

The application section includes an application processor ASIC with DDR/NAND combo memory as the core.

Application processor
The application processor is also called an application ASIC because it is processing application SW and
handles the UI SW. It consists of the application processor and peripheral subsystems such as camera, display
and keyboard driver blocks.

In addition to interfaces mentioned above, the peripherals block includes several different I/O interfaces, for
example, for keyboard, modem chip, audio, Bluetooth and so on.
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Absolute maximum ratings

Signal Min Nom Max Uni
t Notes

Battery voltage (idle) -0.3 +4.5 V Battery voltage maximum value is
specified during charging is active

Battery voltage (Call) +3.2 +4.3 V Battery voltage maximum value is
specified during charging is active

Charger input voltage -0.3 +20 V

Back-Up supply voltage 0 2.5 2.6 V Maximum capacity of the backup
power supply assumed to be 10 µAh.

Phone modes of operation

Mode Description

NO_SUPPLY (dead) mode means that the main battery is not present or its voltage is too low (below
EM ASIC N2200 master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over EM ASIC N2200
master reset threshold. All regulators are disabled, PurX is on low state, the RTC is on
and the oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm),
but the RTC and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. In this mode certain regulators are
enabled and after they and RFClk have stabilized, the system reset (PurX) is released
and PWR_ON mode entered. RESET mode uses 32kHz clock to count the REST mode delay
(typically 16ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.

Voltage limits

Parameter Description Value

VMSTR Master reset threshold (N2200) 2.2V (typ.)

VMSTR+ Threshold for charging, rising (N2300) 2.1V (typ.)

VMSTR- Threshold for charging, falling (N2300) 1.9V (typ.)

VCOFF+ Hardware cutoff (rising) 2.9V (typ.)

VCOFF- Hardware cutoff (falling) 2.6V (typ.)

SWCOFF SW cutoff limit ~3.2V
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The master reset threshold controls the internal reset of EM ASICs. If battery voltage is above VMSTR, N2300
charging control logic is alive. Also, RTC is active and supplied from the main battery. Above VMSTR, N2300
allows the system to be powered on although this may not succeed due to voltage drops during start up. SW
can also consider battery voltage too low for operation and power down the system.

Power key
The system boots up when power key is pressed (adequate battery voltage, VBAT, present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW). Power on key is connected to the EM ASIC N2200 via PWRONX signal.
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Power distribution

Figure 83 Power distribution diagram
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Power supply components:

• CMT module N9101

• EM ASIC N4200

• Application processor VCORE_APE, VIO_APE N4200

• WLAN module supplies: N6303, N6300 and N6301

• Main camera supplies: N8702, N8701 and N8703

• Sub camera suplies: N4200 VDD_ACME

• Mini SD regulator: N4200 VMMC_APE

• Flash LED driver: D8740

• EL driver supplies: N9901 VDD_EL

All the above are powered by the main battery voltage.

Battery voltage is also used on the RF side for power amplifiers (GSM PA & WCDMA PA) and for RF ASICs.

Discrete power supplies are used to generate3.6V/2.8V/1.9V to WLAN, 3.0 V for the camera voltage. The device
supports both 1.8 V/3 V SIM cards which are powered by VSIM1.

USB accessories which need power from the device are powered by N9101 / VOUT.

System power-up
After inserting the main battery, regulators started by HW are enabled. SW checks, if there is some reason to
keep the power on. If not, the system is set to power off state by watchdog. Power up can be caused by the
following reasons:

• Power key is pressed

• Charger is connected

• RTC alarm occurs

• MBUS wake-up

After that:

• N9101 activates sleep clock and VANA, VIO and VR1 regulators.

• Voltage appearing at N9101 RSTX pin is used for enabling other N9101 internal regulators and oscillators.

• VCTCXO regulator is set ON and RF clock (main system clock) is started to produce.

• N9101 will release PURX ~ 16ms after power up is enabled (the RF clock is then stable enough).

• Synchronizing clock (2.4MHz) for N9101 is started to be produced. After PURX is released and two rising
edges of 2.4 MHz synchronous clock have been detected in SMPSClk input N9101 is starting to use that
instead of 600kHz internal RC-oscillator.

• HW start-up procedure has been finalized and the system is up and running. Now it is possible for SW to
switch ON other needed regulators.

Clocking scheme
There are two main clocks in the system: 38.4 MHz RF clock produced by VCTCXO in RF section and 32.768 kHz
sleep clock produced by the CMT module N9101 with an internal crystal.

RF clock is generated only when VCTCXO is powered on by the CMT module regulator. Regulator itself is
activated by SleepX signals from both RAP and application processor. When both CPUs are on sleep, RF clock
is stopped.

RF clock is used by RAP, which provides (divided) 19.2 MHz SysClk further to the application processor. Both
RAP and the application processor have internal PLLs which then create clock signals for other peripheral
devices/interfaces like RS MMC, SIM, CCP, I2C and memories.
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32k Sleep Clock is always powered on after startup. Sleep clock is used by RAP and the application processor
for low-power operation.

SMPS Clk is 2.4 MHz clock line from RAP to EM ASIC N2300 used for switch mode regulator synchronizing in
active mode. In deep sleep mode, when VCTCXO is off, this signal is set to '0'-state.

BT Clk is 38.4 MHz signal from the RF ASIC to the Bluetooth system.

Figure 84 Clocking scheme

Bluetooth/FM module
The Bluetooth and FM radio solution of the device are realized with a combined BT/FM module. This module
has the Bluetooth solution and FM radio solution combined into a single component (BTHFM1.0). However,
the two solutions are electrically isolated from one another.

Bluetooth
The first part of the BTHFM1.0 module contains the Bluetooth. Bluetooth provides a fully digital link for
communication between a master and one or more slave units. The system provides a radio link that offers
a high degree of flexibility to support various applications and product scenarios. Data and control interface
for a low power RF module is provided. Data rate is regurated between the master and the slave.

The Bluetooth device is based on the CSR’s BC4 ASIC. The UART1 interface handles the transfer of control and
data information between the application processor and the Bluetooth system (BC4). The PCM interface is
used for audio data transfer between CeBBO2P ASIC and the Bluetooth system (BC4).
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FM radio
The second part of the BTHFM module contains the FM radio.

The antenna for the FM radio is provided by plugging in an external wired headset to the system connector.
It is not possible to listen to the FM radio without a wired headset connected. The FM radio is controlled by
I2C commands coming from RAP. The audio output of the FM radio is fed to the headset via the EM ASIC N2200,
so the rest of the phone can sleep while the FM radio is active.

USB
USB (Universal Serial Bus) provides a wired connectivity between a USB host PC and peripheral devices.

USB is a differential serial bus for USB devices. USB controller supports USB specification revision 2.0 with full
speed USB (12 Mbps). The device is connected to the USB host through the system connector. The USB bus is
hot plugged capable, which means that USB devices may be plugged in/out at any time.
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WLAN interface
A Wireless Local Area Network (WLAN) is a flexible data communication system in which a mobile user can
connect to a local area network through a wireless connection. The standard, which specifies the technologies
for WLAN, is called IEEE 802.11. The device supports both IEEE 802.11.b and 802.11.g standards, so the support
data rates are from 1 Mbps to 54 Mbps in 2.4 GHz ISM band.

The WLAN module also requires the reference clock of 38.4 MHz.

The WLAN module uses the same VIO as the application processor.

The same antenna is shared with BT and WLAN. When BT_CLK_REQ is activated and WLANENABLE is disabled,
the antenna can be used by BT.

Figure 85 WLAN block diagram

lrda interface
IrDA specifies a low-cost, reliable, fully digital peer-to-peer data link between IrDA units at data rates to
115.2k bits/s. The link is based on the serial transmission of data as pulses of infrared light at the wave length
of 870 nm and angles of +-15 degrees at the range 0 - 50 to 100 cm. Because these restrictions and the optical
nature of the link, the transmission is not omnidirectional but focused, and only reaches a peer at a limited
line-of-sight distance from the transmitter. Therefore, the transmission does not disturb any other units in
the neighbourhood.
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The IR interface is implemented into the application processor. The processor block uses the UART3 circuit
to communicate with a standard IrDA transceiver. The IR transceiver module complies with the IrDA
specification version 1.4. The data rates are in the range of 9600 bit/s to 115200 bits/s.

The IR interface in the application processor and the IR transceiver module use the I/O voltage 1.8 V on the
Rx (processor receive), Tx (processor send), and SD (IR module shutdown) pins. The IR transmission is powered
from the phone battery VBAT (nominal 3.7 V) through a load resistor.

IR communication is half-duplex, meaning that the IR receiver sees its own transmission, and the IR interface
is either transmitting or receiving, but not both at the same time. IrDa modules consume current when the
IR detector is active.

Figure 86 Interconnections between application processor, EM ASICs, and IR module

SIM interface
The device has one SIM (Subscriber Identification Module) Interface. It is accessible only when the battery is
removed.

The SIM interface signals consist of data, clk and rst signals which are controlled by CEBBO2P (Internally by
RAP) and power is taken care by VILMA which is also part of CEBBO2P. There is no separate Flexi PWB for SIM
and all the signals are directly connected from CEBBO2P to SIM connector on the engine PWB.

The SIM IF is shown in the following figure:
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Figure 87 SIM interface

Vilma (energy management ASIC) which is part of CEBBO2P supports both 1.8V and 3.0V SIM cards. The SIM
interface voltage is first 1.8V when the SIM card is inserted. If the card does not respond then 3.0V interface
voltage is used.

The data communication between the card and the phone is asynchronous half duplex, and the clock supplied
to the card is 1-5 MHz, which is 3.2 MHz by default (in GSM system). The baud rate is the SIM clock frequency
divided by 372 (by default), 64, 32 or 16.

MiniSD interface
The Secure Digital (SD) card is supplied with 3 V supply voltage. The detection of SD card removal/insertion
is done by a switch in the card connector. Removing the SD card while writing to it may corrupt all data in
the card.

TV-out interface
A TV-out connection is implemented using the application processor Video DAC (Digital-to-Analogue
Converter) interface and an external analogue line driver. The device engine supports the following systems
using composite video (CVBS):

• M/NTSC

• J/NTSC

• 4.43/NTSC

• M/PAL

• N/PAL

• Nc/PAL

• B/PAL

• G/PAL

• D/PAL

• H/PAL

• I/PAL

CVBS is a single video signal containing all the necessary information to reproduce a colour picture. The video
signal is feed to an external connector.
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Figure 88 TV-out interface block diagram

Battery interface
The phone is powered by a 3-pole BL-5F battery. The three poles are named VBAT, BSI and GND where the
BSI line is used to recognize the battery capacity. This is done by means of an internal battery pull down
resistor.

Figure 89 Battery pin order

Battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line, which
is located on the main PWB, at a place where the phone temperature is most stabile.

The connection from the charger connector to the charger is established via a charger adaptor.

For service purposes, the device software can be forced into local mode by using pull down resistors
connected to the BSI line.

RM-156
System Module Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page 9 –17
Copyright © 2007 Nokia. All rights reserved.

 



User interface

Main display

Display module mechanical concept

Figure 90 General diagram of the LCD module

Display features:

• Module size (width x height x thickness): 41.82mm x 59.41mm x 1.987mm

• Resolution QVGA

• Numbers of colours up to 16.7M (24bits)

• Partial display function; power saving by pausing display process on part of the screen.

• Built-in RAM capacity 240 columns x 320 rows x 24 bits = 1,382,400 bits

The display has two different operating modes:

• Normal mode, Full screen, 16.7M colours

• Partial idle mode, 8 colours but only part of the display is active

The interconnection between the LCD module and the Nokia engine is implemented with a 24-pin board-to-
board connector.

The display is controlled via a MeSSi-16 interface with an 8-bit bus by the application processor. All MeSSi-16
signals go through the EMC filtering ASIPs. The display module does not require any tunings in service.

Keyboard
The device keyboard is connected to the main PWB with a board-to-board connector.

The keyboard has 2 key matrices. The main key pad is in a 5x5 matrix and 5-way key (main) is in another
matrix with 5-way key (sub, which is located on the side).

Key Row#
KBC#

Column#
Kbr#

Switch Ref

5Way Main Up C A S1
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Key Row#
KBC#

Column#
Kbr#

Switch Ref

5Way Main Lt F A S2

5Way Main Dn D A S3

5Way Main Rt E A S4

5Way Main Ctr G A S5

softkey1 4 3 S6

Send 3 0 S7

Edit 4 3 S8

1 0 0 S9

4 1 0 S10

7 2 0 S11

* 0 3 S12

Any 4 0 S13

2 0 1 S14

5 1 1 S15

8 2 1 S16

0 1 3 S17

Softkey2 3 3 S18

END 3 1 S19

Clr 3 2 S20

3 0 2 S21

6 1 2 S22

9 2 2 S23

# 2 3 S24

APP 4 1 S25

5Way Side lt F B S26A

5Way Side Dn D B S26B

5Way Side Up C B S26C

5Way Side Rt E B S26D

5Way Side Ctr G B S26E

Mode 1 4 S27

Flash 2 4 S28
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Figure 91 Keyboard layout

Display backlight

Figure 92 Main display backlight control diagram
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Keyboard backlight
The module has an EL (electroluminescent lamp) sheet to achieve keypad backlighting. Keypad backlight is
switched ON only in dark ambient light conditions.

Switching ON/OFF of the keyboard backlight is controlled by GENOUT1 pin which is connected to CEBBO2P.

Luminance of keypad backlight is always fixed. The brightness of keypad backlighting can't be varied.

Figure 93 Keyboard backlight block diagram

ALS interface
Ambient Light Sensor (ALS) is located in the flip part of the phone. It consists of the following components:

• lightguide (part of the front cover)

• phototransistor (V1) + resistor (R3 )

• NTC + resistor (R2)

• CEBBO2P (N9101)

Information on ambient lighting is used to control the backlights of the phone:

• Keypad lighting is switched on only when the environment is dark / dim

• Display backlights are dimmed, when the environment is dark / dim

• The ambient light sensor itself is a photo transistor, which is temperature-compensated by an external
NTC resistor. N9101 reads the light sensor (LS) and temperature (LST) results. ALS calibration is not possible
in the service points. ALS is serviced by replacing faulty phototransistors.
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Figure 94 ALS hardware implementation

Table 22 ALS resistor values

Symbol R1 R2 R3 R4 R6 R7 NTC-res

Value 5 kOhm
15

kOhm
30

kOhm
50

kOhm
100

kohm
470

kohm
47

kOhm

ASICs
Cellular application ASIC, memories, Energy Management ASICs and many passive components are integrated
into one module.

The module includes the following functional blocks:

• Core supply generation

• Charge control circuitry

• Level shifter and regulator for USB/FBUS

• Current gauge for battery current measuring

• LED driver for backlights

• Digital interface (CBUS)

• Start up logic and reset control

• Charger detection

• Battery voltage monitoring

• 32.768kHz clock with external crystal

• Real time clock with external backup battery

• SIM card interface
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• Stereo audio codecs and amplifiers

• A/D converter

• Regulators

• Vibra interface

Device memories

RAP memories NOR flash and SDRAM
Modem memory consists of 128 Mbit SDRAM and 128 Mbit NOR flash memories.

Combo memory
The application memory of the device consists of NAND/DDR combo memory. The stacked DDR/NAND
application memory has 512 Mbit of DDR memory and 1024 Mbit of flash memory.

 Audio concept

Audio HW architecture
The functional core of the audio hardware is built around two ASICs: RAP CMT engine ASIC and mixed-signal
ASIC (N2200).

The mixed-signal ASIC (N2200) provides an interface for the transducers and the accessory connector. Because
audio amplifiers are also integrated into the ASIC, the only discrete electronics components needed for audio
paths are audio filtering components and EMC/ESD components.

There are three audio transducers:

• 7 x 11 mm dynamic earpiece

• 15 x 11 mm dynamic speaker

• two digital MEMS (Microelectromechanical Systems) microphones

• analog microphone for phone speech

In addition to the audio transducers, N2200 also provides an output for the dynamic vibra component.

All galvanic audio accessories are connected to the system connector.

A Bluetooth audio and FM radio module, which is connected to the RAP ASIC supports Bluetooth audio and
FM radio functionality.

There is also a separate application ASIC for Symbian applications.
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Figure 95 Audio block diagram

Internal digital MEMS microphone
The internal microphone is used for the Internal HandsFree (IHF) call mode, and camcorder stereo recording.

Two digital MEMS microphones are connected to the RAP ASIC (D2800) via an analogue switch IC (N2150).
The microphone power and clock signals are controlled by this switch.

Figure 96 Internal digital microphones circuitry in MicPWR key PWB
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Figure 97 Internal digital microphones circuitry in engine PWB

Internal analog microphone
The internal analog microphone is used for the Handportable (HP) mode.

The microphone is connected to the EM ASIC (N2200) MicIP and GND.

Figure 98 Internal analog microphone circuitry in engine PWB

External microphone
Galvanic accessories are connected to the system connector.

Accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.

Internal earpiece
The internal earpiece is used in the HandPortable (HP) call mode. A dynamic 7 x 11 mm earpiece capsule is
connected directly to the EM ASIC (N2200) differential outputs EarP and EarN through the flip flexi PWB and
micro coaxial cable (X6 - X8900).

Internal speaker
The internal speaker is used in Internal HandsFree (IHF) call mode.

A dynamic 15 x 11 mm speaker is connected to the EM ASIC (N2200) outputs HFSpP and HFSpN through the
flip flexi PWB and micro coaxial cable (X6 - X8900).

The IHF amplifier integrated in N2200 is a Digital Pulse Modulated Amplifier (DPMA).
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Figure 99 Internal speaker circuitry in engine PWB

External earpiece
All galvanic accessories are connected to the system connector.

The accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.

The EM ASIC (N2200) provides two output channels in either single-ended or differential format. N2200
outputs XearL and XearLC form the left channel audio output, and XearR and XearRC the right channel audio
output. XearLC and XearRC are the ground pins if the output works in a single-ended operation. The XearLC
signal is multiplexed with a video output signal coming from the application processor ASIC side.

In the system connector side, HSEAR P and HSEAR N form the left channel output, and HSEAR R P and HSEAR
R N the right channel output. Respectively, HSEAR N and HSEAR R N are the ground pins if the output works
in a single-ended operation.

Figure 100 External microphone and earpieces circuitry in engine PWB

SMD microphone handling
The membranes of SMD microphones are fragile and break easily. It is strictly forbidden to expose the
membrane to a vacuum or to a "compressed air pistol" during cleaning of the board at any phase without
protecting the microphone from the high pressure air.

Note: It is strictly forbidden to touch the membrane. It is recommended that the microphone is not
touched manually at all.
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Vibra circuitry
Vibra is used for the vibra alarm function.

The vibra motor is connected to the EM ASIC (N2200) VibraP and VibraN Pulse Width Modulated (PWM) outputs.

Figure 101 Vibra circuitry

The vibra is connected to the engine PWB through springs attached to the vibra motor body – X2100 and
X2101 are hard gold plated contact pads on the PWB.

System connector
The system connector provides a fully differential 4–wire stereo line-level output connection and a fully
differential 2-wire mono line-level or microphone level input connection.

The handsfree driver in N2200 is meant for the headset.

The output is driven in a fully differential mode. In the fully differential mode, the handsfree pin is the
negative output and the HFCM pin is the positive output. The gain of the handsfree driver in the differential
mode is 6 dB.

The HEAR N is multiplexed with a video output signal. When the video out cable is connected, the system
detects it via ACI, and switches from Xear N signal to video output automatically.
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Figure 102 External audio connector

Table 23 Audio connector pin assignments

Pin #/ Signal
name

Signal
description

Spectral range Voltage/
Current levels

Max or
nominal serial

impedance

Notes

1/ Charge V Charge DC 0-9V/ 0.85A

2/ GND Charge GND - 0.85A 100mΩ (PWB+
conn.)

3/ ACI ACI 1kbits/s Digital 0 / 47Ω Insertion &
removal
detection

2.5-2.78V

4/ Vout DC out DC 2.78V 70 mA 100mΩ (PWB+
conn.)

200mW

2.5V 90mA

9 / XMIC N Audio in 300-8k 1Vpp &

2.5-2.78VDC

10 / XMIC P Audio in 300-8k 1Vpp &

2.5-2.78VDC

11 / HEAR N or
video

Audio out or
video out

20-20k or 0-6M 1Vpp 10Ω or 75Ω Audio, video
multiplex

12 / HEAR P Audio out 20-20k 1Vpp 10Ω

13 / HEAR R N Audio out 20-20k 1Vpp 10Ω Not conn. in
mono

14 / HEAR R P Audio out 20-20k 1Vpp 10Ω Not conn. in
mono
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 Baseband technical specifications

External interfaces

Name of Connection Connector reference

USB X2001 (on engine PWB)

Charger X2000 (on engine PWB)

Headset X2001

SIM X2750 (on engine PWB)

Mini SD X5250 (on engine PWB)

Battery connector X2070 (on engine PWB)

TV-out X2001 (on engine PWB)

ACI interface electrical characteristics

Description Parameter Min Typ Max Unit Notes

Accessory detection

Headset
detection
threshold

1.75 1.9 2.05 V

Headset
detection
hysteresis

25 mV

Headset
detection
pull ups

1 2 4 uA

After Mbus is switched to HeadDet

High-level
input
voltage.

VIH 1.9 x VDDS 2.5/2.98 3.0 V

Low-level
input
voltage

VIL 0 0.2 0.7 x VDDS V

High-level
output
voltage

VOH 2.4 2.5 2.6 V

Low-level
output
voltage

VOL 0 0.3 V

Rise/fall
time

tR/tF 12.5 ns
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VOUT electrical characteristics

Description Parameter Min Max Typical Unit Notes

Vout regulator for
external
accessories

VOUT 2.43 2.57 2.5 V Max load 90mA

USB IF electrical characteristics

Description Parameter Min Max Unit Notes

Absolute maximum voltage
on D+ and D-

VD+/D- -1 4.6 V USB specification revision
2.0

Supply voltage VBUS 4.4 5.25 V

Supply current:

Functioning IVBUS 100 mA

Suspended IVBUS 500 uA

Unconfigured IVBUS 100 mA

High-level input voltage: V

High (driven) VIH 2

High (floating) VIHZ 2.7 3.6

Low-level input voltage VIL 0.8 V

Differential input sensitivity VDI 0.2 V |(D+) - (D-)|

Differential input voltage
range

VCM 0.8 2.5 V Included VDI range

Low-level output voltage VOL 0 0.3 V

High-level output voltage
(driven)

VOH 2.8 3.6 V

Output signal crossover
voltage

VCRS 1.3 2 V

Irda interface signals

Name I/O

(IR module)

Connection Description

IREDA Battery voltage VBAT IR TX LED anode from VBAT
through load resistor

IREDC Not Connected IR TX LED cathode

TxD I APE SYSTEM
ASIC

uart_tx

_irtx

Transmit data input to IR Module
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Name I/O

(IR module)

Connection Description

RxD O APE SYSTEM
ASIC

uart_rx

_irrx

Received data output from IR
Module

SD (sclk) I APE SYSTEM
ASIC

uart3_rts_s
d

Shutdown

VCC EM ASIC VANA IR Module supply voltage, 2.5 V.

Vlogic APE EM chip VIO_APE Supply voltage for IR Module I/O
and digital parts, 1.8 V

GND Ground voltage Ground voltage

Bluetooth signal list
Note: The signal direction is seen from the direction of the Bluetooth system.

Signal
name

I/O From / to Function

RF - Air

ANT I/O BT antenna Bluetooth antenna
port, 50 W

Power

VBAT In Battery Phone battery voltage

VIO In EM ASIC I/O-voltage, 1.8V

Clocking

BTClk In RF System clock, 38.4 MHz

SleepClk In EM ASIC Sleep clock, 32.768 kHz

BT_Clk_Req Out RAP ASIC Clock request signal

Control

BT_ResetX In Application
processor

Bluetooth reset (active
low)

BT_WakeU
p

In Application
processor

Wake up of the
Bluetooth ASIC

UART_Wak
eUp

Out Application
processor

Wake up of the
Application processor

PURX In EM ASIC Enable signal for on-
chip regulators

UART

UART_Rx In Application
processor

UART receiver

UART_Tx Out Application
processor

UART transmitter
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Signal
name

I/O From / to Function

UART_CTS In Application
processor

UART clear to send
(active low)

UART_RTS Out Application
processor

UART request to send
(active low)

PCM

PCM_In In RAP ASIC PCM data in

PCM_Out Out RAP ASIC PCM data out

PCM_Clk In RAP ASIC PCM bit clock, 128 kHz

PCM_Sync In RAP ASIC PCM frame clock, 8 kHz

WLAN module interface signals and supply voltages

Table 24 WLAN module interface signals

Signal name I/O From / to Function

VDD_PA1 In 3.6 V
Regulator

Analog power for RF PA

VDD_PA In 3.6 V
Regulator

Analog power for RF PA

BB_VDD_1.5 In 1.5V SMPS Reg. Digital power for BB

BB_VDD_2.8 In 2.8V
Regulator

Digital I/O power for BB

RF_VDD_2.8 In 2.8V
Regulator

Digital and Analog power for RF

VIO In APE EM ASIC Power for host interface (1.8V)

REF_CLK_BB/
RF

In VCTCXO + RF
engine
(reference
clock)

System clock from the RF engine, 38.4
MHz

CLK_REQ Out RAP Clock request signal

WLANENABLE In Application
processor

WLAN enable/reset

WLAN_IRQ Out Application
processor

WLAN interrupt request

SPI_CLK In Application
processor

SPI clock

SPI_SDI In Application
processor

SPI data in

SPI_SDO Out Application
processor

SPI data out
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Signal name I/O From / to Function

SPI_CSX In Application
processor

SPI chip select

BT_TX_CONFn Out BTHFM Transmission confirmation to
Bluetooth

BT_RF_ACTIVE In BTHFM Bluetooth RF Active

BT_FREQ In BTHFM Bluetooth frequency

BT_STATUS In BTHFM Bluetooth status

BT_TX/RX In/Out BTHFM BT TX/RX port

ANT In/Out Antenna Main ANT, RF Input/Output

Table 25 Power supplies for WLAN module

Power
source

Voltage (V) Load
(mA)

Function

Min. Typ. Max. Max.

VDD_PA 3.6 Analogue power for RF PA

BB_VDD_1.
5

1.5 Digital power for BB

BB 2.8 Power for BB & RF

VIO 1.7 1.8 1.95 10 mA * I/O voltage for the WLAN
baseband

FBUS interface electrical characteristics (between N2300 and Pop-Port)

Description Parameter Min Typ Max Unit

High-level input voltage VIH 2.5 V

Low-level Input voltage VIL 2.5 V

High-level output voltage VOH 2.25 2.5 2.57 V

Low-level output voltage VOL 0 0.15 V

Headset hook detection interface (XMICN) electrical characteristics

Description Min Typ Max Unit Notes

Hook detection
threshold 1

1.25 1.35 1.45 V Two fixed
thresholds
inside N9101.
Selectable by
SW

Hook detection
threshold 2

0.5 0.6 0.7 V

Hook detection
hysteresis

25 mV
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Description Min Typ Max Unit Notes

Hook detection
pull ups

1 2 4 uA

Audio signal electrical characteristics

Description Parameter Typ Unit Notes

XMIC N Audio in 1 Vpp DC Offset 2.5-2.78V

XMIC P Audio in 1 Vpp DC Offset 2.5-2.78V

HSEAR N Audio out 1 Vpp 10Ω nominal serial
impedance

HSEAR P Audio out 1 Vpp 10Ω nominal serial
impedance

HSEAR R N Audio out 1 Vpp 10Ω nominal serial
impedance

Not connected in
mono

HSEAR R P Audio out 1 Vpp 10Ω nominal serial
impedance

Not connected in
mono

SIM IF connections

Pin Signal I/O Engine connection Notes

C1 VSIM Out EM ASIC VSIM1 Supply voltage
to SIM card,
1.8V or 3.0V.

C2 SIMRST Out EM ASIC SIM1Rst Reset signal to
SIM card

C3 SIMCLK Out EM ASIC SIM1ClkC Clock signal to
SIM card

C5 GND - GND Ground

C7 SIMDATA In/Out EM ASIC SIM1DaC Data input /
output

SW SIM_DET In EM ASIC SIMDetX Removal
detection
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MiniSD interface signals and supply voltages

Table 26 miniSD host and card interface signals

Application
processor

signal name

I/O Reset value Description miniSD
card pin

mmc_clko O o, pull down Card clock signal 4

mmc_clki I I, pull down Return clock

mmc_cmd I/O I, pull down Card command /response 9

mmc_dat0 I/O I, pull down Card data0 2

mmc_dat1 I/O I, pull down Card data1 1

mmc_dat2 I/O I, pull down Card data2 11

mmc_dat3 I/O I, pull down Card data3 10

Card power supply 5

Card supply voltage ground
Vss1 Vss2

3,8

I I,High Card detection switch 12

mmc_cmddir O I, pull down CMD direction

mmc_datdir0
-3

O O DATA direction 0-3

Table 27 miniSD interface supply voltages

Parameter Symbol min max unit note

Supply voltage (basic
CMDs)

Vmmc 2 3.6 V CMD0, 15, 55, ACMD41
commands

Supply voltage (other
CMDs)

VCCSD 2.7 3.6 V Other commands

Host I/O supply voltage
1.8 V

VIO 1.71 1.89 V Nominal 1.8 V

Level shifter supply VIO 1.71 1.89 V Same as Host supply

VCCSD Same as Card supply

Supply voltage
differentials (Vss1,2)

GND -0.3 0.3 V
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TV-out interface signals

Table 28 Signaling interface between application processor and OPA361

Signal
name

Application
processor pin

name

OPA361 pin
name [pin
number]

Description, application
processor pin direction

TV_CVBS TV.CVBS] In+ [1] DAC, output

TV_RREF TV.RREF Rset [3] Reference, output

OPA361_En
able

GPIO.6 Enable [5] Enable, output

Charger connector and charging interface connections & electrical characteristics

Figure 103 Charger connector

Table 29 Charging interface connections

Pin Signal I/O Engine connection Notes

1 Vchar In N9101 VCharIn1, 2 Charging
voltage /
charger
detection,
Center pin

2 Charge GND Ground Charger
ground

Table 30 Charging IF electrical characteristics

Description Parameter Min Max Unit Notes

Vchar V Charge 0 9 V Center pin

Vchar I Charge 0.85 A Center pin

Charge GND 0.85 A
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Description Parameter Min Max Unit Notes

Threshold for
charging,
rising (N9101)

VMSTR+ 2.1 V Typical value

Threshold for
charging,
falling (N9101)

VMSTR- 1.9 V Typical value

Battery connector and interface connections & electrical characteristics

Figure 104 Battery connector

Table 31 Battery interface connections

Pin Signal I/O Engine connection Notes

1 VBAT -> N9101 VBAT Battery voltage

2 BSI -> N9101 BSI Battery size
indication
(fixed resistor
inside the
battery pack)

3 GND GND Ground

Table 32 Battery IF electrical characteristics

Description Parameter Max Unit

Operation voltage VIN 4.23 VDC

Current rating IIN 0.9 A

Internal interfaces

Name of Connection Connector reference

UI connector X4400

Display X4401

Main camera X8901

Sub camera X8901

ALS V4400
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Name of Connection Connector reference

Vibra M2100

Microphone B2100

Earpiece B2101

IHF speaker B2102

UI connections

Table 33 User interface connections

Pin Signal I/O Engine connection Notes

1 GND GND

2 LED+ <- N2301 VLEDOUT2

Discrete
Backlight SMPS
(controlled by
EM ASIC N2300)

3 Col2 -> D4800 Kbc_2

4 LED-

->

R2305 + V2300 SETCURR2

Serial resistor +
Transistor
switch
(controlled by
EM ASIC N2300)

5 Col1
->

D4800 Kbc_1
Voice switch
connection

6 GND GND

7 Row3 -> D4800 Kbr_3

8 Row2 -> D4800 Kbr_2

9 Row1 -> D4800 Kbr_1

10 Row6 -> D4800 Kbr_6

11 Row0 -> D4800 Kbr_0

12 Col0 -> D4800 Kbc_0

13 Row5 -> D4800 Kbr_5
Voice switch
connection

14 Row4 -> D4800 Kbr_4

15 GND GND

16 Col3 -> D4800 Kbc_3

Keyboard interface electrical characteristics

Description Parameter Min Typ Max Unit Notes

High-level
input voltage

VIH 0.65* VDDS VDDS 0.3+ VDDS V Row
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Description Parameter Min Typ Max Unit Notes

Low-level
input voltage

VIL -0.3 0 0.35* VDDS V Row

High-level
output
voltage

VOH 1.62 VDDS 1.98 V Column

Low-level
output
voltage

VOL 0 0.45 V Column

(VDDS = 1.8V)

Display interface connections

Table 34 Main display connections

Pin name in Engine Display pin name

VLEDOUT_LCD (1)VLED+

(Connect to VLED1- on display module) (2)VLED2+

VAUX (3)VDD

GND (4)GND

Dss_pclk(Application processor) (5)RDX

Dss_acbias(Application processor) (6)D/CX

Dss_d1(Application processor) (7)D1

Dss_d3(Application processor) (8)D3

GND (9)GND

Dss_d5(Application processor) (10)D5

Dss_d7(Application processor) (11)D7

Dss_d16(Application processor) (12)TE

GPIO30(Application processor) (13)RESX

Dss_hsync(Application processor) (14)CSX

Dss_d6(Application processor) (15)D6

Dss_d4(Application processor) (16)D4

Dss_d2(Application processor) (17)D2

GND (18)GND

Dss_d0(Application processor) (19)D0

Dss_vsync(Application processor) (20)WRX

GND (21)GND

VIO_APE (22)VDDI

MAIN_LED- (23)VLED2-
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Pin name in Engine Display pin name

(Connect to VLED2+ on display module) (24)VLED1-

Table 35 Sub display connections

Pin name in Engine Display pin name

VIO_APE (1)VDDI

GPIO15(Application processor) (2)RESX

Spi1_simo(Application processor) (3)SDA

Spi1_clk(Application processor) (4)SCL

Spi1_ncs2(Application processor) (5)CSX

VAUX (6)VDD

N.C. (7)TE

GND (8)GND

SUB_LED- (9)LED-

VLEDOUT_LCD (10)LED+

Camera IF connections and electrical characteristics

Table 36 Camera interface connections

Main Camera I/O Camera IF
PWB I/O The other side Notes

Pin Signal Signal Part Signal Part Ref PWB

1 GND Ground line

2
CIFVD
D

->
CIFVD
D

X3 -> VDD
Sub
Camera

X10
Flip
PWB

Sub camera
power supply

3 GND Ground line

4
CIFVD
D

->
CIFVD
D

X3 -> VDD
Sub
Camera

X10
Flip
PWB

Sub camera
power supply

5 GND Ground line

6 CIFEN -> CIFEN X3 -> EN
Sub
Camera

X10
Flip
PWB

Sub camera
serial data
enable

7 FCLK <- FCLK X4 <-
SYS.CLK
OUT

Applicati
on
process
or

D4800
Engine
PWB

Main camera
system clock

8 CIFSCL -> CIFSCL X3 -> CIFSCL
Sub
Camera

X10
Flip
PWB

Sub camera
serial clock

9 GND Ground line
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Main Camera I/O Camera IF
PWB I/O The other side Notes

10 CIFSDA -> CIFSDA X3 -> CIFSDA
Sub
Camera

X10
Flip
PWB

Sub camera
serial data

11 PWDN <- PWDN X4 <- GPIO45

Applicati
on
process
or

D4800
Engine
PWB

Main camera
power down
control

12
CIFHP
A

->
CIFHP
A

X3 -> HPA
Sub
Camera

X10
Flip
PWB

Sub camera
horizontal sync

13 AVDD <- AVDD X4 <- AVDD
Regulat
or

N870
2

Engine
PWB

Main camera
analog power
supply

14 CIFVRR -> CIFVRR X3 -> VRR
Sub
Camera

X10
Flip
PWB

Sub camera
vertical sync

15 AVDD <- AVDD X4 <- AVDD
Regulat
or

N870
2

Engine
PWB

Main camera
analog power
supply

16 CIFESR -> CIFESR X3 -> ESR
Sub
Camera

X10
Flip
PWB

Sub camera
shutter control

17 DVDD <- DVDD X4 <- DVDD
Regulat
or

N870
3

Engine
PWB

Main camera
digital power
supply

18
CIFRES
ET

->
CIFRES
ET

X3 -> SRST
Sub
Camera

X10
Flip
PWB

Sub camera reset
control

19 DVDD <- DVDD X4 <- DVDD
Regulat
or

N870
3

Engine
PWB

Main camera
digital power
supply

20
CIFMC
K

->
CIFMC
K

X3 -> MCK
Sub
Camera

X10
Flip
PWB

Sub camera
system clock

21 IOVDD <- IOVDD X4 <-
VIO_AP
E

Menelau
s

N420
0

Engine
PWB

Main camera I/O
power supply

22
CIFDAT
A8

<-
CIFDAT
A8

X3 <- D8
Sub
Camera

X10
Flip
PWB

Sub camera
parallel data

23 IOVDD <- IOVDD X4 <-
VIO_AP
E

Menelau
s

N420
0

Engine
PWB

Main camera I/O
power supply

24
CIFDAT
A7

<-
CIFDAT
A7

X3 <- D7
Sub
Camera

X10
Flip
PWB

Sub camera
parallel data

25 RESET <- RESET X4 <- GPIO42

Applicati
on
process
or

D4800
Engine
PWB

Main camera
reset control

26
CIFDAT
A6

<-
CIFDAT
A6

X3 <- D6
Sub
Camera

X10
Flip
PWB

Sub camera
parallel data
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Main Camera I/O Camera IF
PWB I/O The other side Notes

27 GND Ground line

28
CIFDAT
A5

<-
CIFDAT
A5

X3 <- D5
Sub
Camera

X10
Flip
PWB

Sub camera
parallel data

29 GND Ground line

30
CIFDAT
A4

<-
CIFDAT
A4

X3 <- D4
Sub
Camera

X10
Flip
PWB

Sub camera
parallel data

31 GND Ground line

32
CIFDAT
A3

<-
CIFDAT
A3

X3 <- D3
Sub
Camera

X10
Flip
PWB

Sub camera
parallel data

33 SCL <- SCL X4 <-
I2C2_SC
L

Applicati
on
process
or

D4800
Engine
PWB

Main camera I2C
serial clock

34
CIFDAT
A2

<-
CIFDAT
A2

X3 <- D2
Sub
Camera

X10
Flip
PWB

Sub camera
parallel data

35 SDA
<-
>

SDA X4
<-
>

I2C2_SD
A

Applicati
on
process
or

D4800
Engine
PWB

Main camera I2C
serial data

36
CIFDAT
A1

<-
CIFDAT
A1

X3 <- D1
Sub
Camera

X10
Flip
PWB

Sub camera
parallel data

37 GND Ground line

38
CIFDAT
A0

<-
CIFDAT
A0

X3 <- D0
Sub
Camera

X10
Flip
PWB

39 CLK+ -> CLK+ X4 -> CLKP

Applicati
on
process
or

D4800
Engine
PWB

CCP clock plus

40 LGND
Ground line
corresponding
to LVDD

41 CLK- -> CLK- X4 -> CLKN

Applicati
on
process
or

D4800
Engine
PWB

CCP clock minus

42 LGND
Ground line
corresponding
to LVDD

43 GND Ground line

44 LGND
Ground line
corresponding
to LVDD
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Main Camera I/O Camera IF
PWB I/O The other side Notes

45 D+ -> D+ X4 -> DATAP

Applicati
on
process
or

D4800
Engine
PWB

CCP data plus

46
STROB
E

->
STROB
E

X4 -> STROBE
FLED
Driver

D8740
Engine
PWB

Main camera
strobe control

47 D- -> D- X4 -> DATAN

Applicati
on
process
or

D4800
Engine
PWB

CCP data minus

48 LVDD <- LVDD X4 <- LVDD
Regulat
or

N870
1

Engine
PWB

Main camera
lens power
supply

49 GND Ground line

50 LVDD <- LVDD X4 <- LVDD
Regulat
or

N870
1

Engine
PWB

Main camera
lens power
supply

Table 37 Camera supply voltage characteristics

Description Parameter Min Typ Max Unit

Main camera
analogue
power supply

AVDD 2.9 3.0 3.1 V

Main camera
digital power
supply

DVDD 2.9 3.0 3.1 V

Main camera I/
O power supply

IOVDD 1.7 1.8 1.9 V

Main camera
lens power
supply

LVDD 2.9 3.0 3.1 V

Sub camera
power supply

CIFVDD 2.9 3.0 3.1 V

Flash LED interface and electrical characteristics

Table 38 Flash LED / indicator LED interface connections

Signal name From To Description

GPIO41 D4800 V8720 Indicator LED enable
signal

GPIO92 D4800 D8740 Flash LED mode control
signal
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Signal name From To Description

GPIO44 D4800 D8740 Flash LED enable signal
from APE

STROBE Main camera D8740 Flash LED enable signal
from main camera

Table 39 Flash LED interface electrical characteristics

Description Description Parameter Min Typ Max Unit

GPIO41 Indicator
LED enable
signal

GPIO output 1.72 1.8 1.92 V

GPIO92 Flash LED
mode
control
signal

GPIO output 1.72 1.8 1.92 V

GPIO44 Flash LED
enable
signal from
APE

GPIO output 1.72 1.8 1.92 V

STROBE Flash LED
enable
signal from
main
camera

Main camera
output

2.9 3.0 3.1 V

Back-up battery interface electrical characteristics

Table 40 Back-up battery connections

Pin name I/O Connection Notes

L2207,
VBack

-> N2200,
VBack

Back-up battery G2200 is
connected to N2200 via coil

Table 41 Back-up battery electrical characteristics

Description Parameter Min Typ Max Unit

Back-Up
Battery
Voltage

Vback 0 2.5 2.7 V

 RF description

Receiver

Introduction to receiver functionality
Receiver functions are implemented in an RF ASIC.
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The receiver is a linear direct conversion receiver consisting of separate front ends (LNA (Low Noise Amplifier)
and demodulator) for each supported system. After the demodulators, the signal paths are combined to one
common BB path.

WCDMA receiver functionality
In the WCDMA mode, the received signal is fed from the antenna to a duplex filter. After the duplex filter the
signal goes via a balun to an LNA (Low Noise Amplifier) residing in N7500. From the LNA, the signal goes
trough a band pass filter.

After filtering, the signal goes to the down conversion mixer, which converts the signal to baseband I and Q
signals. At the BB frequency the signal is amplified, and fed to a low pass filter. The Rx channel filter must be
calibrated with an automatic routine whenever the Rx ASIC IC is changed to a phone.

In the WCDMA mode, the corner frequency of the filter is set to approximately 2.1 MHz. The filter is followed
by an AGC (Automatic Gain Control) amplifier with an adjustable gain. The signal is further amplified before
it is fed to balanced analogue IQ output pins. The analogue output pins are accompanied by reference voltage
output, which sets the DC level for the AD converter in the BB ASIC RAP.

The last stage of the RF Rx chain is an output buffer which feeds the signal and a reference voltage (VREFCM)
to the BB ASIC.

GSM receiver functionality
As GSM Rx branches are functionally identical, the following description is applicable to all of them.

The received signal goes from the GSM antenna to the antenna switch module.

The antenna switch module is followed by integrated LNAs residing in the Rx ASIC.

The LNAs are followed by demodulators which downconvert the signal to baseband I and Q signals.

After the down conversion mixer, the Rx chain is similar to the WCDMA Rx. The channel select filter is set to
115 kHz in the GSM mode.

Transmitter

Introduction to transmitter functionality
Transmitter functions are implemented in an RF ASIC. The ASIC contains a BB frequency low pass filter, which
is tunable according to the signal bandwidth of the system in use.

In addition, the ASIC contains separate RF paths comprising a final frequency IQ modulator and VGA amplifiers.

WCDMA transmitter functionality
In the transmitter side, an analogue I/Q modulated signal is received from digital baseband into an RF ASIC
and fed through a low pass filter. After the filter the signal is fed to the IQ modulator, which converts the
signal to final Tx frequency. There are two separate I/Q modulators: one for WCDMA and another for GSM
signals. The signal then exits the RF ASIC via a balanced line. Next, the signal is band pass filtered by a SAW
filter before it is fed to the WCDMA PA module. After the PA, the transmitted WCDMA signal is fed through an
isolator and a duplex filter to the antenna.

WCDMA power control
WCDMA Tx power control is accomplished by the two VGA amplifier stages in the Tx ASIC.

The VGAs have a common temperature compensation circuit and one voltage mode analogue input for gain
control (TXC).

Another function of the detector voltage is to steer the DC/DC converter, which is providing a variable supply
voltage for the WCDMA PA.
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WCDMA PA module
The WCDMA PA is housed in a separate module having:

• a variable supply voltage input for the amplifier stages (Vcc11),

• a battery supply voltage for the bias circuits (Vcc12),

• and two bias current inputs.

Bias currents are generated by 5-bit DA converters in the RF ASIC.

If a different manufacturer's PA is changed to the phone, this setting must be set again.

PA DC/DC converter
The control of the DC/DC converter is fed back from the power detector circuit.

GSM transmitter functionality
An RF ASIC receives an analogue IQ modulated signal from the digital BB. The signal is first low pass filtered,
and then routed to the GSM modulator. The amplifier gives 40 dB of power control dynamic range.

After the VGA stage the signal exits the RF ASIC. In case of GSM1800/1900 the signal goes directly to the GSM
PA module. In case of EGSM900 (and GSM850, if applicable), the PA module is preceded by a SAW filter. After
the filter, the signal is fed to the GSM Tx front-end module (TXFEM), which also contains the antenna switch.

GSM power control
A closed control loop comprise an integrated power detector (in PA module) and an error amplifier. The error
amplifier resides in N7501, and it controls the transmitter power of GSM.

Detector output from the PA gives a DC level proportional to the output power. The DC voltage is fed to the
negative input of the error amplifier, where it is compared to the level of the reference signal, TXC. TXC is
received from the BB circuitry. The output of the error amplifier is fed to a buffer amplifier, which in turn
steers the VGA amplifier.

The power control loop is enabled and disabled by writing an appropriate register in N7501 RF ASIC. In case
of dual slot transmission, the output power is ramped down between the consecutive slots.

GSM PA module
The TXFEM module contains two separate amplifier chains, one for EGSM900 (and GSM850, if applicable) and
another for GSM1800/1900. Both amplifiers have a battery supply connection and two bias current inputs.

Antennas
This product has two internal antennas; main antenna and Bluetooth/WLAN antenna. Both antennas are
made of flex film radiator, and attached with an adhesive on the plastic block.

Main (GSM/WCDMA) antenna
The Main (GSM/WCDMA) antenna is used for either GSM or WCDMA protocols, enabled by SP3T switch on the
engine PWB. The antenna has one feed and one parasitic contacts. The antenna has matching components
on the PWB.
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Figure 105 Main antenna (GSM/WCDMA)

Figure 106 Main antenna contact

Buletooth/WLAN antenna
The Bluetooth/WLAN antenna is used for both Bluetooth and WLAN protocols, enabled by switching inside
the WLAN module.

The antenna has one feed and one GND contact.

The antenna has matching components on the PWB.
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Figure 107 Bluetooth/WLAN Antenna

Figure 108 Bluetooth/WLAN contact

Frequency synthesizers
RF has separate synthesizers for Rx and Tx. Both synthesizers consist of:

• PLL (Phase-Locked Loop)

• loop filter

• VCO (Voltage Controlled Oscillator)

• balun

The VCO frequencies are locked by PLLs into a reference oscillator, VCTCXO (Voltage Controlled Temperature
Compensated Crystal Oscillator).

The PLLs are located in RF ASICs and controlled via RFBus.

Reference oscillators
A 38.4MHz VCTCXO is used as a reference oscillator for the frequency synthesizers.

Regulators
All RF regulators, except one, are located in the EM ASIC N2200 in the baseband section or in the RF ASIC N7501
of the device. The discreet regulator, N7541 feeds the WCDMA PA. The EM ASIC N2200 has three regulators
for RF:

1 2.78 V regulator VXO

2 4.75 V regulator VCP (VCP1 & VCP2)

3 1.35 V regulator, VB_EXT, which is the reference voltage
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 Frequency mappings

EGSM900 frequencies
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GSM1800 frequencies
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GSM1900 frequencies
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WCDMA 2100 Rx frequencies
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WCDMA 2100 Tx frequencies
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